# Contents

## Preface

<table>
<thead>
<tr>
<th>Audience</th>
<th>x</th>
</tr>
</thead>
<tbody>
<tr>
<td>Documentation Accessibility</td>
<td>x</td>
</tr>
<tr>
<td>Related Documents</td>
<td>x</td>
</tr>
<tr>
<td>Conventions</td>
<td>xi</td>
</tr>
</tbody>
</table>

## Changes in This Release

Changes in Oracle Application Express Release 19.1  xii

## 1 About Oracle Application Express

1.1 Browser Requirements  1-1
1.2 About Oracle Application Express  1-1
1.3 About Database Applications  1-2
1.4 About Websheet Applications  1-2

## 2 Using Interactive Grids

2.1 About Interactive Grids  2-2
2.2 About Editable Interactive Grids  2-3
2.3 Accessing Interactive Grids  2-4
   2.3.1 About Interactive Grid URLs  2-4
   2.3.2 Accessing an Interactive Grid  2-5
2.4 Using an Interactive Grid  2-6
   2.4.1 Searching in an Interactive Grid  2-6
      2.4.1.1 About the Search Bar  2-6
      2.4.1.2 Using the Select Columns To Search Icon  2-7
   2.4.2 Rearranging Columns Using Drag and Drop  2-7
   2.4.3 Resizing Columns in an Interactive Grid  2-8
   2.4.4 Sorting Columns in an Interactive Grid  2-9
   2.4.5 Using Charts in an Interactive Grid  2-10
2.5 Customizing an Interactive Grid with the Actions Menu  2-11
2.5.1 Changing the Column Display in an Interactive Grid 2-12
2.5.2 Filtering an Interactive Grid 2-13
  2.5.2.1 About Filters in Interactive Grids 2-13
  2.5.2.2 Creating a Row Filter in an Interactive Grid 2-14
  2.5.2.3 Creating a Column Filter in an Interactive Grid 2-14
  2.5.2.4 Editing a Filter in an Interactive Grid 2-15
  2.5.2.5 Disabling a Filter in an Interactive Grid 2-15
  2.5.2.6 Removing a Filter from an Interactive Grid 2-16
2.5.3 Selecting Column Sort Order in an Interactive Grid 2-17
2.5.4 Defining an Aggregation in an Interactive Grid 2-17
  2.5.4.1 Creating an Aggregation in an Interactive Grid 2-17
  2.5.4.2 Editing an Aggregation in an Interactive Grid 2-19
  2.5.4.3 Removing an Aggregation in an Interactive Grid 2-20
2.5.5 Creating a Control Break from the Actions Menu in an Interactive Grid 2-21
2.5.6 Adding Highlighting to an Interactive Grid 2-22
2.6 Customizing an Interactive Grid with the Column Heading Menu 2-23
  2.6.1 About the Column Heading Menu in an Interactive Grid 2-24
  2.6.2 Displaying the Column Heading Menu 2-25
  2.6.3 Creating a Control Break in an Interactive Grid 2-25
  2.6.4 Creating an Aggregation with the Column Heading Menu 2-27
  2.6.5 Freezing Columns in Place 2-28
  2.6.6 Hiding Columns in an Interactive Grid 2-28
  2.6.7 Unhiding Columns in an Interactive Grid 2-29
  2.6.8 Filtering with the Column Heading Menu 2-30
2.7 Using an Editable Interactive Grid 2-31
  2.7.1 Adding a Row in an Editable Interactive Grid 2-31
  2.7.2 Editing Rows in an Interactive Grid 2-32
    2.7.2.1 About the Row Actions Menu in an Editable Interactive Grid 2-32
    2.7.2.2 About the Edit Button in an Editable Interactive Grid 2-33
    2.7.2.3 Editing a Cell in an Interactive Grid 2-34
    2.7.2.4 Editing Multiple Rows in an Editable Interactive Grid 2-34
  2.7.3 Deleting a Row in an Interactive Grid 2-35
  2.7.4 Modifying Multiple Rows and Cells in an Editable Interactive Grid 2-35
    2.7.4.1 About Selection Modes in an Editable Interactive Grid 2-35
    2.7.4.2 Changing Selection Mode in an Editable Interactive Grid 2-36
    2.7.4.3 Copying to Multiple Rows in an Editable Interactive Grid 2-36
    2.7.4.4 Copying to Multiple Cells in an Editable Interactive Grid 2-37
    2.7.4.5 Filling Cells in an Editable Interactive Grid 2-38
    2.7.4.6 Clearing Cells in an Interactive Grid 2-38
2.8 Saving Interactive Grids 2-39
  2.8.1 About Interactive Grid Report Types 2-39
3.7.10.1 Creating a Group By 3-21
3.7.10.2 Editing a Group By 3-22
3.7.10.3 Selecting a Group By Sort Order 3-22
3.7.10.4 Deleting a Group By 3-22

3.7.11 Managing Pivot Reports 3-23
3.7.11.1 Creating a Pivot Report 3-23
3.7.11.2 Editing a Pivot Report 3-24
3.7.11.3 Deleting a Pivot Report 3-24

3.7.12 Executing a Flashback Query 3-25
3.7.12.1 Creating a Flashback Query 3-25
3.7.12.2 Editing a Flashback Query 3-25
3.7.12.3 Deleting a Flashback Query 3-25

3.7.13 Saving an Interactive Report 3-26
3.7.13.1 About the Report List 3-26
3.7.13.2 About Configuration Dependencies 3-27
3.7.13.3 Saving a Public or Private Interactive Report 3-27
3.7.13.4 Renaming a Public or Private Interactive Report 3-28
3.7.13.5 Deleting a Public or Private Interactive Report 3-28

3.7.14 Resetting a Report 3-29
3.7.15 Downloading a Report 3-29

3.7.16 Subscribing to Report Updates by Email 3-30
3.7.16.1 How Report Subscriptions Work 3-30
3.7.16.2 Subscribing to Updated Report Results 3-30

4 Data Loading Wizard Examples
4.1 About Using the Data Loading Wizard 4-1
4.2 Importing Data from a File into Your Application 4-2
4.3 Copying and Pasting Data into Your Application 4-5

5 Using Websheets
5.1 About Websheet Applications 5-2
5.2 Accessing Websheets 5-2
  5.2.1 About Websheet URLs 5-3
  5.2.2 Accessing a Websheet 5-3
5.3 Using Websheets 5-4
  5.3.1 Breadcrumb Sections 5-4
  5.3.2 Navigation Sections 5-5
  5.3.3 Showing and Hiding Page Sections 5-6
  5.3.4 Online Help 5-6
5.3.5 Signing out of a Websheet 5-6
5.3.6 About the Websheet Search Bar 5-7
5.3.7 Control Panel 5-8
5.4 Managing Websheet Pages 5-8
  5.4.1 Adding a New Page 5-9
  5.4.2 Copying an Existing Page 5-9
  5.4.3 Editing Page Details 5-10
5.5 Adding and Editing Page Sections 5-10
  5.5.1 About Page Section Types 5-11
  5.5.2 Editing Page Sections 5-11
  5.5.3 Deleting Page Sections 5-12
  5.5.4 Editing Section Titles and Display Order 5-12
5.6 Adding and Editing Text Sections 5-13
  5.6.1 Adding a Text Section 5-14
  5.6.2 Editing a Text Section 5-14
5.7 Adding a Navigation Section 5-16
5.8 Managing Data Grids 5-17
  5.8.1 About Data Grids 5-18
  5.8.2 Creating a Data Grid 5-18
    5.8.2.1 Creating a Data Grid from Scratch 5-18
    5.8.2.2 Creating a Data Grid by Copying and Pasting Spreadsheet Data 5-19
  5.8.3 Copying a Data Grid 5-20
  5.8.4 Viewing and Editing a Data Grid 5-20
    5.8.4.1 Accessing the Data Page 5-21
    5.8.4.2 Toggling Check Boxes 5-22
    5.8.4.3 Editing Data Grid Data 5-23
    5.8.4.4 Editing Data Grid Columns Manually 5-23
    5.8.4.5 Editing Data Grid Rows Manually 5-24
    5.8.4.6 Editing a Single Data Grid Row 5-25
    5.8.4.7 Adding Annotations to a Single Data Grid Row 5-25
    5.8.4.8 Displaying Annotation Columns in a Data Grid Report 5-26
    5.8.4.9 Displaying Pseudo Columns in a Data Grid Report 5-26
    5.8.4.10 Editing Data Grid Properties 5-27
    5.8.4.11 Creating a Bookmark Link to a Data Grid 5-27
  5.8.5 Viewing the Data Grid Change History Log 5-28
  5.8.6 Deleting a Data Grid 5-28
5.9 Adding and Editing Data Content 5-28
  5.9.1 About Available Data Sources 5-29
  5.9.2 Enabling Support for Creating Data Reports 5-29
  5.9.3 About Incorporating Data into Websheet Pages 5-29
5.10 Adding Data Reports 5-30
Index
Preface

Oracle Application Express End User’s Guide offers an introduction to using Oracle Application Express applications from an end user’s perspective. This guide explains how to use interactive grids, interactive reports, Websheets, and use applications that include the ability to upload data.

• Audience
• Documentation Accessibility
• Related Documents
• Conventions

Audience

Oracle Application Express End User’s Guide is intended for end users who are running Oracle Application Express applications. To use this guide, you must have a general understanding of relational database concepts and an understanding of the operating system environment under which you are running Oracle Application Express.

Documentation Accessibility

For information about Oracle's commitment to accessibility, visit the Oracle Accessibility Program website at http://www.oracle.com/pls/topic/lookup?ctx=acc&id=docacc.

Access to Oracle Support

Oracle customers that have purchased support have access to electronic support through My Oracle Support. For information, visit http://www.oracle.com/pls/topic/lookup?ctx=acc&id=info or visit http://www.oracle.com/pls/topic/lookup?ctx=acc&id=trs if you are hearing impaired.

Related Documents

For more information, see these Oracle resources:

• Oracle Application Express Release Notes
• Oracle Application Express Installation Guide
• Oracle Application Express App Builder User's Guide
• Oracle Application Express Administration Guide
• Oracle Application Express SQL Workshop Guide
Conventions

The following text conventions are used in this document:

<table>
<thead>
<tr>
<th>Convention</th>
<th>Meaning</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>boldface</strong></td>
<td>Boldface type indicates graphical user interface elements associated with an action, or terms defined in text or the glossary.</td>
</tr>
<tr>
<td><em>italic</em></td>
<td>Italic type indicates book titles, emphasis, or placeholder variables for which you supply particular values.</td>
</tr>
<tr>
<td><strong>monospace</strong></td>
<td>Monospace type indicates commands within a paragraph, URLs, code in examples, text that appears on the screen, or text that you enter.</td>
</tr>
</tbody>
</table>
Changes in This Release

- Changes in Oracle Application Express Release 19.1

Changes in Oracle Application Express Release 19.1

The following are changes in Oracle Application Express End User's Guide for Oracle Application Express release 19.1.

- New Features
- Deprecated and Desupported Features
- Other Changes

New Features


Deprecated and Desupported Features

See Deprecated Features and Desupported Features in Oracle Application Express Release Notes.

Other Changes

The following are additional changes in the release:

- All content has been updated to reflect new functionality.
- Screen captures and graphics have been added and updated to reflect the current Oracle Application Express user interface.
About Oracle Application Express

Oracle Application Express is a rapid web application development tool for the Oracle Database.

- **Browser Requirements**
  Oracle Application Express requires a JavaScript-enabled browser and supports the current and prior major release of Google Chrome, Mozilla Firefox, Apple Safari, Microsoft Internet Explorer, and Microsoft Edge.

- **About Oracle Application Express**
  Oracle Application Express is a rapid web application development tool for the Oracle Database.

- **About Database Applications**
  A database application is an interactive user interface (UI) that enables you to display, add, update, or delete information stored in a local Oracle Database or an external data source using REST-based APIs. A database application can display information in many formats, including static and interactive reports, forms, charts, and interactive grids.

- **About Websheet Applications**
  Websheet applications are interactive web pages that combine text with data. You can define these highly dynamic applications in a number of ways.

> **See Also:**
> "Quick Start" in *Oracle Application Express App Builder User’s Guide*

### 1.1 Browser Requirements

Oracle Application Express requires a JavaScript-enabled browser and supports the current and prior major release of Google Chrome, Mozilla Firefox, Apple Safari, Microsoft Internet Explorer, and Microsoft Edge.

> **Note:**
> Microsoft Internet Explorer 11 is the prior major release, with Microsoft Edge being the current Microsoft browser.

### 1.2 About Oracle Application Express

Oracle Application Express is a rapid web application development tool for the Oracle Database.
Developers assemble an HTML interface (or application) on top of database objects with wizards or direct input. Each application is a collection of linked pages using tabs, buttons, or hypertext links.

You can manage, manipulate, and display the data in a local Oracle Database or an external data source using REST-based APIs.

Developers can build two types of applications in Oracle Application Express:

- Database applications
- Websheet applications

1.3 About Database Applications

A database application is an interactive user interface (UI) that enables you to display, add, update, or delete information stored in a local Oracle Database or an external data source using REST-based APIs. A database application can display information in many formats, including static and interactive reports, forms, charts, and interactive grids.

This guide explains how you can customize interactive grids and interactive reports. In an interactive grid or interactive report, you can customize the appearance of report data through searching, filtering, sorting, column selection, highlighting, and other data manipulations. You can save your customizations in the application or, depending on the developer’s configuration, you can also download reports locally for offline use.

This guide also explains how to import data into an Oracle Application Express application using an existing application Data Loading Wizard.

See Also:

- "Using Interactive Grids"
- "Using Interactive Reports"
- "Data Loading Wizard Examples"

1.4 About Websheet Applications

Websheet applications are interactive web pages that combine text with data. You can define these highly dynamic applications in a number of ways.

Websheet applications include navigation controls, search capabilities, and the ability to add annotations such as files, notes, and tags. Websheet applications can be secured using access control lists and several built-in authentication models.

See Also:

"Using Websheets"
2

Using Interactive Grids

An interactive grid presents a set of data in a searchable, customizable report. In an editable interactive grid, users can also add to, modify, and delete the data set directly on the page.

- **About Interactive Grids**
  Interactive grids feature many ways to change how the data is displayed. Options include the Actions menu, Column Heading menus, and the ability to rearrange the report interactively using the mouse.

- **About Editable Interactive Grids**
  Editable interactive grids possess all the same functionality of regular interactive grids, plus some additional functions in the interface and the customization menus. You can add, edit, delete, and refresh much of the underlying data in an editable grid.

- **Accessing Interactive Grids**
  Access an interactive grid by logging into the database application and navigating to the interactive grid URL.

- **Using an Interactive Grid**
  Use the interactive grid’s menus and interface to search the grid, add elements such as filters and computations, reorganize with sort and breaks, and further customize how the data displays.

- **Customizing an Interactive Grid with the Actions Menu**
  Reconfigure and augment how an interactive grid displays data by using the Actions menu.

- **Customizing an Interactive Grid with the Column Heading Menu**
  Use the Column Heading menu to quickly customize a column in an interactive grid.

- **Using an Editable Interactive Grid**
  Editable interactive grids expand the functionality of regular interactive grids to enable you to more directly update a grid’s structure and contents. You can add and delete rows, edit cell contents, and refresh the grid with the latest updates.

- **Saving Interactive Grids**
  Save your changes as a new report within the application. Name and keep these interactive grid reports Private or make them Public to share with other users.

- **Resetting Interactive Grids**
  You can refresh, reset, or flashback a grid to revert your changes to it. Resetting an interactive grid can have different outcomes depending on the report type.

- **Downloading or Emailing an Interactive Grid**
  Obtain the data of an interactive grid as a CSV or HTML file by selecting Download in the Actions menu.
2.1 About Interactive Grids

Interactive grids feature many ways to change how the data is displayed. Options include the Actions menu, Column Heading menus, and the ability to rearrange the report interactively using the mouse.

Interactive Grid Interface

By default, all interactive grids have a search bar, Actions menu, and Reset button. Interactive grids also have Column Heading Menus, which you access by clicking the name or heading of a column.
You can hide, filter, freeze, highlight, sort, and create control breaks on individual columns with the Actions and Column Heading menus. Advanced users can also define aggregations, which appear at the bottom of the column or column group.

Using the mouse, you can resize columns or drag and drop columns into different places to directly customize the appearance of an interactive grid. (The width and order of columns can also be configured in the Columns dialog.)

You can quickly chart the data with the Chart function. This feature is useful for quick data visualization or even presentation, and responds immediately to changes in the data.

You can quickly revert your modifications with the Reset function or perform an incremental revert with the Flashback function. You can use the Refresh function to pull in the latest version of the data on the database (useful for highly dynamic datasets).

Reports in Interactive Grids

You can save your customizations to an interactive grid by creating a custom report by selecting Report, Save As from the Actions menu.

See Also:
- About Interactive Grid Report Types

2.2 About Editable Interactive Grids

Editable interactive grids possess all the same functionality of regular interactive grids, plus some additional functions in the interface and the customization menus. You can add, edit, delete, and refresh much of the underlying data in an editable grid.
About Editable Interactive Grids

While an interactive grid provides users with a searchable, sortable, and customizable set of data, with an editable interactive grid you can also change or update the data. An editable interactive grid allows you to select, add, and change a grid's contents in real time, similar to working in spreadsheet software.

Editable Cells

You can change the contents of an individual cell in real time by double-clicking a cell. You can also toggle the Edit button to enable improved keyboard usability when updating multiple columns. For example, rather than pointing and clicking on every cell in the grid, you can use the Tab and Ctrl + Tab keys to move focus across cells in a row.

Editable Rows

The primary way of adding new content to an editable interactive grid is by adding new rows. You can use the Row Actions menu to edit an individual row, or the Selection Actions menu to edit multiple rows at once.

2.3 Accessing Interactive Grids

Access an interactive grid by logging into the database application and navigating to the interactive grid URL.

- About Interactive Grid URLs
  You can access interactive grids directly with their URL. Interactive grid URLs contain an application ID and a page ID. When you access an application page, the session ID also generates in the address bar.

- Accessing an Interactive Grid
  Access an interactive grid by navigating to the URL provided by your application developer. Ensure the URL includes the application ID and page ID, but not the session state ID.

2.3.1 About Interactive Grid URLs

You can access interactive grids directly with their URL. Interactive grid URLs contain an application ID and a page ID. When you access an application page, the session ID also generates in the address bar.

Parts of an Interactive Grid URL

The following is an example of an Interactive Grid URL:


f?p=
Indicates that you are accessing an Oracle Application Express application.

4350
The application ID. The application ID specifies which application to access.
The **page ID**. The page ID specifies which page to access within the application. Depending on how the developer configured the page, the page ID may be a word, such as `home`.

**WARNING:**

Do not enter the session ID when you access an interactive grid URL. Entering information beyond the page ID displays an error.

**See Also:**

"About Session IDs" in *Oracle Application Express App Builder User’s Guide*

### 2.3.2 Accessing an Interactive Grid

Access an interactive grid by navigating to the URL provided by your application developer. Ensure the URL includes the application ID and page ID, but not the session state ID.

If you do not have a URL or the URL does not work, contact the developer.

To access an interactive grid:

1. Click the supplied URL, or enter it in your browser's Address field.
   
   A Sign In page appears.

2. On the Sign In page:
   
   a. Username - Enter your username.
   
   b. Password - Enter your password.
   
   c. Click **Sign In**.

   The interactive grid appears.

**See Also:**

"Understanding Session State Management" in *Oracle Application Express App Builder User’s Guide*
2.4 Using an Interactive Grid

Use the interactive grid’s menus and interface to search the grid, add elements such as filters and computations, reorganize with sort and breaks, and further customize how the data displays.

- **Searching in an Interactive Grid**
  Search an interactive grid by entering criteria into the Search Bar.

- **Rearranging Columns Using Drag and Drop**
  Drag and drop a column into place by clicking and holding the drag handle on the column heading.

- **Resizing Columns in an Interactive Grid**
  Resize the width of a column by clicking and holding the edge of a column heading and adjusting it with the mouse.

- **Sorting Columns in an Interactive Grid**
  Specify the alphabetical, numerical, or chronological order of a column by clicking the Sort Ascending and Sort Descending buttons on the column heading.

- **Using Charts in an Interactive Grid**
  Create a chart in an interactive grid by selecting Chart in the Actions menu. Edit or remove the chart with the Edit Chart filter.

2.4.1 Searching in an Interactive Grid

Search an interactive grid by entering criteria into the Search Bar.

**Tip:**

You can also search an interactive grid using a supported browser’s search function (such as Ctrl + F or Cmd + F).

- **About the Search Bar**
  You can perform text searches with the Search Bar at the top of an interactive grid.

- **Using the Select Columns To Search Icon**
  Narrow your search parameters by clicking the Select Columns to Search icon (magnifying glass).

2.4.1.1 About the Search Bar

You can perform text searches with the Search Bar at the top of an interactive grid.
Select Columns to Search icon
Resembles a magnifying glass. Narrows your search.
See "Using the Select Columns To Search Icon."

Text area
Displays entered search criteria (wildcard characters are implied).

Go button
Executes a search.

2.4.1.2 Using the Select Columns To Search Icon

Narrow your search parameters by clicking the Select Columns to Search icon (magnifying glass).

To search a specific column:
1. Click the Select Columns to Search icon.
2. Select the name of a column.
3. (Optional) To enable case sensitive searching, select Case Sensitive.
4. Enter a search string in the Search field.
5. Press the Enter key or click Go.

The interactive grid reloads with a filter applied.
To reset the search bar back to the default setting, click the Select Columns to Search icon and select All Text Columns.

You may need to disable or remove existing filters for broader searching to take effect.

See Also:
- Disabling a Filter in an Interactive Grid
- Removing a Filter from an Interactive Grid

2.4.2 Rearranging Columns Using Drag and Drop

Drag and drop a column into place by clicking and holding the drag handle on the column heading.

You can also rearrange the order of the columns in the Columns dialog.

To drag and drop a column:
1. Hover the mouse over a column heading to display the drag handle.
The mouse cursor also changes when it comes into contact with the drag handle.

2. Click and hold the drag handle.
3. Drag the column to the desired location.
   The heading shifts out of place in the row.
4. While holding the mouse, use the indicator to determine which column to place the dragged column ahead of.
5. Release the mouse.
   The column drops into place.

To undo all changes, click the **Reset** button.

⚠️ **WARNING:**

Resetting an interactive grid reverts it to a previously saved state. Any changes since that time may be lost.

---

### See Also:

- Changing the Column Display in an Interactive Grid

---

### 2.4.3 Resizing Columns in an Interactive Grid

Resize the width of a column by clicking and holding the edge of a column heading and adjusting it with the mouse.

To resize a column with your mouse:

1. Hover your mouse cursor over the edge of column heading until the cursor changes.

```
<table>
<thead>
<tr>
<th>Status</th>
<th>Cost</th>
</tr>
</thead>
<tbody>
<tr>
<td>Leg...</td>
<td>0</td>
</tr>
<tr>
<td>St ser</td>
<td>0</td>
</tr>
</tbody>
</table>
```

2. Click and hold the mouse.
3. Move the mouse left and right to achieve the desired width.
4. Release the mouse.
   The column resizes.

To undo all changes, click the **Reset** button.
2.4.4 Sorting Columns in an Interactive Grid

Specify the alphabetical, numerical, or chronological order of a column by clicking the Sort Ascending and Sort Descending buttons on the column heading.

To specify the sort order of a column:
1. Hover the mouse in the column heading.
   - The Sort Ascending and Sort Descending buttons display.
2. Do one of the following:
   - To sort a column in ascending order (A to Z, 1 to 9, earliest to latest), click the Sort Ascending button (up arrow).
   - To sort a column in descending order (Z to A, 9 to 1, latest to earliest), click the Sort Descending button (down arrow).
   - To remove an existing sort, click the toggled button again (now labeled Don’t Sort).
The column sorts.

2.4.5 Using Charts in an Interactive Grid

Create a chart in an interactive grid by selecting Chart in the Actions menu. Edit or remove the chart with the Edit Chart filter.

To create a chart from the data in an interactive grid:

1. Click the Actions menu and select Chart.
   The Chart dialog appears.

2. Select a chart type.
   The dialog populates with options specific to the selected chart type. For example, a bar chart has a different set of configuration fields than a pie chart. Select different types to see the range of available options.

3. Configure the chart settings.
   For example, the following is a configuration for a Bar chart:
   - Orientation - Select Vertical for the bars to increase toward the top of the chart, or Horizontal to increase toward the right.
   - Label - Select the column to be used as the Label (the label appears beneath or beside the bar).
   - Value - Select the column to be used as the Value (the value is the quantity that determines the size of the bar).
   - Aggregation - (Optional) Select an additional aggregation to be performed on the column selected for the Value. Valid selections include: Count, Count Distinct, Minimum, Maximum, Sum, or Average.

4. Click Save.
The chart appears. The following is an example of a bar chart that depicts project budgets with a sum aggregation. To switch the view between Grid and Chart, click the toggle that now appears at the top of the interactive grid.

To reconfigure the chart, click the Edit Chart filter.

To remove a chart, click the Remove Chart icon (X) adjacent to the chart filter.

You can only create one chart at a time in an interactive grid. To create a second chart, reconfigure the existing chart by clicking Edit Chart, or delete it by clicking the adjacent Remove Chart icon (X).

2.5 Customizing an Interactive Grid with the Actions Menu

Reconfigure and augment how an interactive grid displays data by using the Actions menu.
2.5.1 Changing the Column Display in an Interactive Grid

Edit which columns display and in what order by selecting Columns in the Actions menu.

Filtering an Interactive Grid
Filter an interactive grid by column, row, or both, with text strings and using operators such as contains and equals.

Selecting Column Sort Order in an Interactive Grid
Specify the sort order (ascending or descending) of a column by selecting Sort on the Data submenu. You can also specify how to handle NULL values.

Defining an Aggregation in an Interactive Grid
Define an aggregation in an interactive grid by selecting Aggregate from the Actions, Format submenu. Aggregates display after each control break and at the end of the interactive grid within the column for which they are defined.

Creating a Control Break from the Actions Menu in an Interactive Grid
Break an interactive grid (that is, compartmentalize the layout) by column by selecting Control Break in the Actions, Format submenu.

Adding Highlighting to an Interactive Grid
Apply color effects to an interactive grid by selecting Highlight in the Actions, Format submenu.
To edit how columns display in an interactive grid:

1. Click the **Actions** menu and select **Columns**. The Columns dialog displays.

2. Edit the columns:
   - **Displayed** - Select the check box to show a column in the grid; deselect a check box to hide a column in the grid.
   - **Move Up** and **Move Down** - Adjust the order in which a column appears in the grid.
   - **Columns** button - Toggle whether the list displays **All**, **Displayed**, or **Not Displayed** (hidden) columns.
   - **Minimum Column Width** (Pixel) - Adjust the displayed numeric value to widen or narrow the column (for example, a higher number widens the column).

3. Click **Save**. The interactive grid refreshes.

### 2.5.2 Filtering an Interactive Grid

Filter an interactive grid by column, row, or both, with text strings and using operators such as **contains** and **equals**.

- **About Filters in Interactive Grids**
  You can narrow the contents of an interactive grid by applying a filter to it. Once applied, filters can be temporarily enabled or disabled or removed permanently directly in the interactive grid. You can also click the filter name for quick reconfiguration.

- **Creating a Row Filter in an Interactive Grid**
  Create a row filter to limit the number of rows returned in an interactive grid. Filtering by row filters for a term in any filterable column.

- **Creating a Column Filter in an Interactive Grid**
  Filter a column in an interactive grid with a specified operator and value.

- **Editing a Filter in an Interactive Grid**
  Edit a filter by clicking the name of a filter to open the Filters dialog. The Filters dialog enables you to edit properties of any filter.

- **Disabling a Filter in an Interactive Grid**
  Disable a filter by clicking the check box adjacent to the name of the filter.

- **Removing a Filter from an Interactive Grid**
  Remove a filter by deleting it in the Filters dialog or by clicking the adjacent Remove Filter icon (X).

### 2.5.2.1 About Filters in Interactive Grids

You can narrow the contents of an interactive grid by applying a filter to it. Once applied, filters can be temporarily enabled or disabled or removed permanently directly in the interactive grid. You can also click the filter name for quick reconfiguration.
Existing filters display between the search bar and the grid.

Rather than deleting a filter, you can disable it by deselecting the adjacent checkbox. You can leave a filter disabled and save your report to preserve it for future usage.

To edit a filter, you can click its name or open the Filters dialog and select it in the list.

You can permanently remove a filter by clicking the adjacent Remove Filter icon (X) or by removing it from the list in the Filters dialog.

2.5.2.2 Creating a Row Filter in an Interactive Grid

Create a row filter to limit the number of rows returned in an interactive grid. Filtering by row filters for a term in any filterable column.

To add a filter to the rows in an interactive grid:

1. Click the Actions menu.
2. Select Filter.
   The Filters dialog displays.
3. In the Filters dialog:
   a. Type - Select Row.
   b. Search - Enter the text string to filter.
   c. Case Sensitive - Enable to make the filter case sensitive.
4. Click Save.
   The interactive grid applies the filter.

2.5.2.3 Creating a Column Filter in an Interactive Grid

Filter a column in an interactive grid with a specified operator and value.
To add a filter to a column in an interactive grid:

1. Click the Actions menu.
2. Select Filter.
   The Filters dialog displays.
3. In the Filters dialog:
   a. Type - Select Column.
   b. Column - Choose the column to filter.
   c. Operator - Choose the filter logic.
   d. Value - Enter the filter criterion.
4. Click Save.
   The filter is added to the grid.

2.5.2.4 Editing a Filter in an Interactive Grid

Edit a filter by clicking the name of a filter to open the Filters dialog. The Filters dialog enables you to edit properties of any filter.

To edit an existing filter:

1. Click the name of a filter.
   The Filters dialog displays.
2. Edit the filter by selecting new values.
   Editable parameters include:
   • the filter type (row, column)
   • the name of the row or column the filter applies to
   • the filter operator
   • the filtered value
   Other filters can also be added, edited, enabled, and removed in this dialog.
3. To add a new filter:
   a. Click the Add button (+) adjacent to the Filters list.
   b. Configure the appropriate fields.
4. Click Save to apply your changes.

2.5.2.5 Disabling a Filter in an Interactive Grid

Disable a filter by clicking the check box adjacent to the name of the filter.

Disabling a filter is often preferable to deleting it because disabling saves the time of recreating and reconfiguring the same filter.

• To disable a filter in an interactive grid:
  • Click the check box adjacent to the name of the filter.

The interactive grid reloads and the check box unchecks.
To re-enable the filter, click the check box again.
2.5.2.6 Removing a Filter from an Interactive Grid

Remove a filter by deleting it in the Filters dialog or by clicking the adjacent Remove Filter icon (X).

Tip:
To temporarily disable a filter, deselect the adjacent check box either within the Filters dialog or above the interactive grid.

To remove a filter, do one of the following:

• Open the Filters dialog and delete it:
  1. Click the Actions menu and select Filter.
     The Filters dialog appears.
  2. In the list of filters, select the filter to remove.
  3. Click the Delete button (-).

 4. Click Save.

• Above the interactive grid, click the Remove Filter icon (X) adjacent to a filter.
2.5.3 Selecting Column Sort Order in an Interactive Grid

Specify the sort order (ascending or descending) of a column by selecting Sort on the Data submenu. You can also specify how to handle NULL values.

To sort by column:
1. Click the Actions menu, select Data, then Sort.
   The Sort dialog appears.
2. In the Sort dialog: Select a column, the sort direction (Ascending or Descending), and the null sorting behavior (Default, Nulls Always Last, or Nulls Always First).
   a. Column - Select a column.
   b. Direction - Select Descending or Ascending.
   c. Nulls - Select First or Last.
3. To add another sort rule, click the Add button (+).
4. Click Save.
   The interactive grid reloads.

2.5.4 Defining an Aggregation in an Interactive Grid

Define an aggregation in an interactive grid by selecting Aggregate from the Actions, Format submenu. Aggregates display after each control break and at the end of the interactive grid within the column for which they are defined.

- Creating an Aggregation in an Interactive Grid
  Create an aggregation in an interactive grid by selecting Aggregate in the Actions, Data submenu.
- Editing an Aggregation in an Interactive Grid
  Edit an existing aggregations by selecting the Aggregate in the Actions, Data submenu.
- Removing an Aggregation in an Interactive Grid
  Use the Aggregate dialog to remove an aggregation.

2.5.4.1 Creating an Aggregation in an Interactive Grid

Create an aggregation in an interactive grid by selecting Aggregate in the Actions, Data submenu.

To create an aggregation against a column:
1. Click the Actions menu, select Data, then Aggregate.
   The Aggregation dialog appears. (Some fields may be pre-filled.)
2. In the Aggregation dialog:
   a. **Column** – Select the column to define against
   b. **Aggregation** – Select the type of aggregation to apply
   c. **Tooltip** – (Optional) Add a label that appears when you hover the mouse over the aggregation.
   d. (Optional) **Show Overall Value** – Select to display the grand total of a column

3. To add another aggregation:
   a. Click the **Add** icon (+).
      A new Aggregation appears in the list.
   b. Define the new aggregation as described in the previous step.

4. Click **Save**.
   The result of the aggregation appears at the bottom of the last page of the report.

The following example is an interactive grid with two sum aggregations applied to two different columns (a control break has also been applied to simplify the presentation):
2.5.4.2 Editing an Aggregation in an Interactive Grid

Edit an existing aggregations by selecting the Aggregate in the Actions, Data submenu.

To edit an aggregation with the Aggregate dialog:

1. Click the Actions menu.
2. Select the Data submenu, then Aggregate.
   The Aggregate dialog displays.
3. Select an aggregation.
4. Edit the aggregation. Editable fields include the column to define against, the function type, Tooltip, and Show Overall Value.
5. Click Save.
2.5.4.3 Removing an Aggregation in an Interactive Grid

Use the Aggregate dialog to remove an aggregation.

**Tip:**

You can delete or disable an aggregation by interacting with the aggregation filter above the interactive grid. To delete an aggregation, click the **Remove Aggregation** icon (X); to disable an aggregation, select the adjacent check box.

To remove an aggregation with the Aggregation dialog:

1. Click the **Actions** menu.
2. Select the **Data** submenu, then **Aggregate**. The Aggregation dialog displays.
3. Do one of the following:
   - To hide an aggregation from view in the grid, click the adjacent checkbox in the Enabled column. This disables the aggregation and stores it for future use in the Aggregation dialog.
   - To remove the selected aggregation from the grid completely and permanently, click the **Delete** icon (→).
4. Click **Save**.

### 2.5.5 Creating a Control Break from the Actions Menu in an Interactive Grid

Break an interactive grid (that is, compartmentalize the layout) by column by selecting Control Break in the Actions, Format submenu.

Creating a break group pulls the columns out of the interactive grid and displays them as a master record.

To create a control break:

1. Click the **Actions** menu and select **Format** then **Control Break**.
   
   The Control Break dialog displays.

2. In the Control Break dialog:
   
   a. **Column** - Select the name of the column.
   
   b. **Direction** - Select the sort direction (**Ascending** or **Descending**).
   
   c. **Nulls** - Select the null sorting behavior (**First** or **Last**).

3. Click **Save**.

The interactive grid reloads with the control break applied for the selected column, and a control break filter appears above the grid near the toolbar.

In the following example, a control break has been applied to the interactive grid for the Project column.
To edit a control break, click the name to display the Control Break dialog. You can also add, edit, and delete other control breaks in the Control Break dialog.

To remove a control break, click the Remove Control Break icon (X) on the control break filter.

See Also:

About Filters in Interactive Grids

2.5.6 Adding Highlighting to an Interactive Grid

Apply color effects to an interactive grid by selecting Highlight in the Actions, Format submenu.

To highlight an interactive grid cell:

1. Click Actions and select Format then Highlight.
   The Highlight dialog displays.

2. In the Highlight dialog:
   a. Name - Enter the name of the highlight (this name displays as a filter above the interactive grid).
b. Highlight - Choose the Row or Column to apply the highlight.

c. Background Color - Select the color of the background in a highlighted cell. Choose a specific RGB value or a basic color from a list of presets.

d. Text Color - Select the color of the text in a highlighted cell. Choose a specific RGB value or a basic color from a list of presets.

3. (Optional) In the Highlight dialog, configure advanced highlighting conditions. For example, to conditionally highlight all tasks with a Status of Closed:

a. Condition Type - Select Column.

b. Column - Select Status.

c. Operator - Select equals.

d. Value - Click the arrow to display the drop-down list of valid values and select Closed from the drop-down list.

4. To add an additional highlight, click the Add icon (+); click the Delete icon (—) to remove an existing highlight.

5. Click Save.

2.6 Customizing an Interactive Grid with the Column Heading Menu

Use the Column Heading menu to quickly customize a column in an interactive grid.

- **About the Column Heading Menu in an Interactive Grid**
  The Column Heading Menu contains buttons to sort, break, aggregate, freeze, and hide a column, as well as a text filter for searching within a column.

- **Displaying the Column Heading Menu**
  Display a column’s Column Heading menu by clicking the heading of the column.

- **Creating a Control Break in an Interactive Grid**
  Create a break group in an interactive grid by clicking the Control Break icon in the Column Heading menu.

- **Creating an Aggregation with the Column Heading Menu**
  Quickly apply an aggregation to an interactive grid by clicking the Aggregate icon in the Column Heading menu.

- **Freezing Columns in Place**
  Freeze a column in place by clicking the Freeze icon in the Column Heading menu. Freezing a column excludes it from the scrollable area so that the frozen column is always visible.

- **Hiding Columns in an Interactive Grid**
  Hide a column in an interactive grid from view by clicking the Hide icon in the Column Heading menu.

- **Unhiding Columns in an Interactive Grid**
  Show a hidden column in an interactive grid by opening the Columns dialog and enabling it in the Displayed column.

- **Filtering with the Column Heading Menu**
  Filter an interactive grid by the contents of a column by entering keywords in the Search field of the Column Heading menu.
2.6.1 About the Column Heading Menu in an Interactive Grid

The Column Heading Menu contains buttons to sort, break, aggregate, freeze, and hide a column, as well as a text filter for searching within a column.

Overview

The Column Heading menu contains Sort Order buttons, a Toolbar, a Text Filter, and a unique list of the column’s contents.

Sort Order Buttons

The Sort Ascending and Sort Descending buttons appear at the right of every column heading.

See "Sorting Columns in an Interactive Grid."

Button Toolbar

The toolbar on the Column Heading menu contains the following buttons and functions.

Control Break

Creates a Control Break in the interactive grid based on the selected column. See "Creating a Control Break in an Interactive Grid."

Aggregate

Opens the Aggregation dialog to define an aggregation against the selected column. See "Creating an Aggregation in an Interactive Grid."

---

Chapter 2

Customizing an Interactive Grid with the Column Heading Menu

2-24
**Freeze**
Freezes the selected column in place, preventing horizontal scrolling.
See "Freezing Columns in Place."

**Hide**
Hides the selected column from view.
See "Hiding Columns in an Interactive Grid."

**Text Filter**
The text filter dynamically limits the list of column contents based on the text string entered into the filter field.
See "Filtering with the Column Heading Menu."

### 2.6.2 Displaying the Column Heading Menu

Display a column’s Column Heading menu by clicking the heading of the column.

To display a column’s Column Heading menu:
- Click the heading of a column in an interactive grid.

The Column Heading menu displays.

### 2.6.3 Creating a Control Break in an Interactive Grid

Create a break group in an interactive grid by clicking the Control Break icon in the Column Heading menu.
Creating a break group pulls the columns out of the interactive grid and displays them as a master record.

To create a control break:

1. Click the heading of the desired break group column.
   - The Column Heading menu appears.

2. Click the **Control Break** icon.
   - The interactive grid reloads with the control break applied for the selected column, and a control break filter appears above the grid near the toolbar.

In the following example, a control break has been applied to the interactive grid for the **Project** column.
To remove a control break, click the Remove Control Break icon (X) on the control break filter.

See Also:

- About Filters in Interactive Grids
- Creating a Control Break from the Actions Menu in an Interactive Grid

### 2.6.4 Creating an Aggregation with the Column Heading Menu

Quickly apply an aggregation to an interactive grid by clicking the Aggregate icon in the Column Heading menu.

![Image of Column Heading Menu with Aggregate option highlighted]

To apply an aggregation against a selected column:

1. Click the heading of the column to display the Column Heading menu.
2. Click the Aggregate icon.
   
   The Aggregation dialog appears.
3. Configure the aggregation.
4. Click Save.
   
   The interactive grid reloads with the aggregation applied.

See Also:

"Creating an Aggregation in an Interactive Grid"
2.6.5 Freezing Columns in Place

Freeze a column in place by clicking the Freeze icon in the Column Heading menu. Freezing a column excludes it from the scrollable area so that the frozen column is always visible.

To freeze a column in place:

1. Click the heading of the column that you wish to freeze. The Column Heading menu appears.
2. Click the Freeze icon. The scroll bar resizes to fit the new scrollable area.

To unfreeze a frozen column, reopen the Column Heading menu and click the Unfreeze icon (snowflake).

2.6.6 Hiding Columns in an Interactive Grid

Hide a column in an interactive grid from view by clicking the Hide icon in the Column Heading menu.

To hide a column in an interactive grid:

1. Click the heading of the column to display the Column Heading menu.
2. Click the Hide icon. The column disappears. Remaining columns shift sideways to fill the space.
To redisplay hidden columns:

3. Click the **Actions** menu.

4. Select **Columns**.
   
   The Columns dialog displays.

5. In the Displayed column, select the check box adjacent to the name of the hidden column.

   **Tip:**
   
   Narrow the list of columns to only the hidden columns by clicking the **Columns** icon and selecting **Not Displayed**.

6. Click **Save**.

   **Tip:**
   
   You can also reset the grid to redisplay a hidden column. Resetting an interactive grid reverts it to a previously saved state. Any changes since that time may be lost. To reset the grid, click the **Reset** button.

### 2.6.7 Unhiding Columns in an Interactive Grid

Show a hidden column in an interactive grid by opening the Columns dialog and enabling it in the Displayed column.
To show a hidden column in an interactive grid:

1. Click the **Actions** menu.
2. Select **Columns**.
   The Columns dialog displays.
3. In the Displayed column, select the check box adjacent to the name of the hidden column.

   **Tip:**
   Narrow the list of columns to only the hidden columns by clicking the **Columns** icon and selecting **Not Displayed**.

4. Click **Save**.
   The column appears in the interactive grid.

### 2.6.8 Filtering with the Column Heading Menu

Filter an interactive grid by the contents of a column by entering keywords in the Search field of the Column Heading menu.

To filter an interactive grid by column:

1. Click the heading of the column that you wish to sort by.
   The Column Heading menu displays.
2. Do one of the following:
   • Click within the Filter... text area.
   • Press the Tab key until the cursor is within the Filter... text area.

3. Enter the text string you wish to filter by. Wildcards (such as quotation marks) are valid.

4. Do one of the following:
   • Press Enter to execute the filter.
   • Select an entry from a list of valid strings that autogenerates when you start typing.

The interactive grid redisplays with the filter applied.
To remove a filter, click the adjacent Remove Filter icon (X).

See Also:
"Filtering an Interactive Grid"

2.7 Using an Editable Interactive Grid

Editable interactive grids expand the functionality of regular interactive grids to enable you to more directly update a grid's structure and contents. You can add and delete rows, edit cell contents, and refresh the grid with the latest updates.

• Adding a Row in an Editable Interactive Grid
  Click the Add Row button to add a new row to an editable interactive grid.

• Editing Rows in an Interactive Grid
  Edit rows of an editable interactive grid with the Row Actions Menu, Edit button, and other functions in the interface.

• Deleting a Row in an Interactive Grid
  Use the Row Actions Menu to delete a row from an editable interactive grid.

• Modifying Multiple Rows and Cells in an Editable Interactive Grid
  Quickly modify the values of multiple rows and cells with the Actions, Selection submenu.

2.7.1 Adding a Row in an Editable Interactive Grid

Click the Add Row button to add a new row to an editable interactive grid.
• To add a new row to the top of an editable interactive grid:
  • Click the **Add Row** button.

A blank row appears at the top of the grid or below the currently selected row.

### 2.7.2 Editing Rows in an Interactive Grid

Edit rows of an editable interactive grid with the Row Actions Menu, Edit button, and other functions in the interface.

- **About the Row Actions Menu in an Editable Interactive Grid**
  The Row Actions Menu appears in editable interactive grids. Users can quickly edit the rows of an editable grid with functions such as adding, duplicating, deleting, refreshing, and reverting rows.

- **About the Edit Button in an Editable Interactive Grid**

- **Editing a Cell in an Interactive Grid**
  Double-click a cell in an editable interactive grid to edit the contents.

- **Editing Multiple Rows in an Editable Interactive Grid**
  Select the desired rows of an editable interactive grid to edit, then select an option from the Selection Actions menu.

#### 2.7.2.1 About the Row Actions Menu in an Editable Interactive Grid

The Row Actions Menu appears in editable interactive grids. Users can quickly edit the rows of an editable grid with functions such as adding, duplicating, deleting, refreshing, and reverting rows.
Single Row View
Changes the grid display to a single-page view of a row's contents. Used for viewing an individual row in detail, one row at a time. Click the Previous and Next buttons to navigate between rows in the grid. Click the Report View button to return to the grid.

Add Row
Adds a new row below the current one.

Duplicate Row
Creates a copy of the currently selected row and inserts the copy below the original.

Delete Row
Deletes the row.

Refresh Row
Reloads the row by calling the database and pulling in any updates. Refresh a row to update it without reloading the entire application page.

Revert Changes
Undoes any changes to the row since the grid was last saved.

See Also:
Editing Multiple Rows in an Editable Interactive Grid

2.7.2.2 About the Edit Button in an Editable Interactive Grid
The Edit button toggles Editing mode in editable interactive grids. When enabled, you can single-click a cell to edit it; when disabled, you must double-click. While Editing mode enables quicker editing of multiple cells in succession, it can impede navigation in larger grids.
2.7.2.3 Editing a Cell in an Interactive Grid

Double-click a cell in an editable interactive grid to edit the contents.

To edit the contents of a single cell in an editable interactive grid:

1. Double-click a cell.
   
   Editing mode engages and a cursor displays in the cell.

2. Edit the cell contents.

3. Press **Tab** or **Shift + Tab** to edit an adjacent cell in the row or **Enter** or **Shift + Enter** to edit an adjacent cell in the column.

4. To exit editing mode, press **Escape**.

5. Click **Save** to save your changes.

Changes to the interactive grid are saved.

2.7.2.4 Editing Multiple Rows in an Editable Interactive Grid

Select the desired rows of an editable interactive grid to edit, then select an option from the Selection Actions menu.

To edit multiple rows in an editable interactive grid:

1. Select rows by selecting check boxes in the check box column.

   **Tip:**

   Click the check box in the column heading to select all rows. With all rows selected, click it again to deselect all rows.

2. In the column heading of the interactive grid, click the **Selection Actions** menu icon.

3. Select a valid option. Options include Copy to Clipboard, Duplicate Rows, Delete Rows, Refresh Rows, Revert Changes, Copy Down, Fill, and Clear.

   The selected change applies.
2.7.3 Deleting a Row in an Interactive Grid

Use the Row Actions Menu to delete a row from an editable interactive grid.

To delete a row from an editable grid:

1. Click the **Row Actions** menu icon adjacent to the row.
2. Select **Delete Row**.

   The row is crossed out in the grid.
3. To finalize the deletion, click **Save**.

   The grid reloads with the selected row removed.

2.7.4 Modifying Multiple Rows and Cells in an Editable Interactive Grid

Quickly modify the values of multiple rows and cells with the Actions, Selection submenu.

- **About Selection Modes in an Editable Interactive Grid**
  You can select rows or groups of cells in an interactive grid by toggling between selection modes.

- **Changing Selection Mode in an Editable Interactive Grid**
  Switch between Cell Selection mode and Row Selection mode by using the Actions, Selection submenu.

- **Copying to Multiple Rows in an Editable Interactive Grid**
  Copy the value of a row and apply it to a group of rows by using Copy Down in the Actions, Selection submenu.

- **Copying to Multiple Cells in an Editable Interactive Grid**
  Copy the value of a cell and apply it to a group of cells in the same column by using Copy Down in the Actions, Selection submenu.

- **Filling Cells in an Editable Interactive Grid**
  Apply a single value to a group of cells in an editable interactive grid by using Fill in the Actions, Selection submenu.

- **Clearing Cells in an Interactive Grid**
  Delete the contents of multiple cells by using Clear in the Actions, Selection submenu.

2.7.4.1 About Selection Modes in an Editable Interactive Grid

You can select rows or groups of cells in an interactive grid by toggling between selection modes.
Row Selection
Row Selection is the default selection mode in interactive grids. Check boxes appear next to every row in the left-hand column, so you can select multiple individual rows at once by mouse-click. You can also press the arrow keys on the keyboard to navigate up and down between rows, or hold the Shift key at the same time to select multiple adjacent rows. With multiple rows selected, you can use the Selection menus to apply a single change to the entire selection.

Cell Selection
You can switch to Cell Selection mode in the Selection submenu in the Actions menu or by pressing \textit{F8}.
In Cell Selection mode, the check boxes disappear, and you can select individual cells by mouse-click. You can also hold the Shift key and use mouse or the arrow keys to select multiple adjacent cells. With multiple cells selected, you can use the Selection menus to apply a single change to the entire selection.

2.7.4.2 Changing Selection Mode in an Editable Interactive Grid
Switch between Cell Selection mode and Row Selection mode by using the Actions, Selection submenu.
Interactive grids are in Row Selection mode by default. You can switch to selection modes to select groups of rows or cells.

1. To switch selection modes, do one of the following:
   - Click the \textit{Actions} menu, select \textit{Selection}, and click \textit{Cell Selection} or \textit{Row Selection}.
   - Press \textit{F8} on your keyboard (\textit{Tip}: ensure only one or no objects are selected).
   The selection mode switches.
2. To switch back, repeat this step.

2.7.4.3 Copying to Multiple Rows in an Editable Interactive Grid
Copy the value of a row and apply it to a group of rows by using Copy Down in the Actions, Selection submenu.
To apply the value of an existing row to a group of rows below it:

1. Ensure you are in \textit{Row Selection} mode.
2. Select the row you want to copy.
3. Do one of the following to select the rows you want to change:
   - Using the mouse, click the adjacent check boxes. Using the check boxes enables you to apply changes to non-contiguous rows.
   - Using the keyboard, press the \textit{down arrow key} to quickly select a group of adjacent rows below the first row (press the \textit{up arrow key} to de-select rows).
4. Click the \textit{Actions} menu, select \textit{Selection}, and select \textit{Copy Down}.
Tip:

You can also use the Selection Actions menu in the header row to quickly access several Selection submenu options (including Copy Down).

The first row is copied to the rows selected below it.

Tip:

Undo changes to the data by clicking Revert Changes in the Selection or Selection Actions menus.

2.7.4.4 Copying to Multiple Cells in an Editable Interactive Grid

Copy the value of a cell and apply it to a group of cells in the same column by using Copy Down in the Actions, Selection submenu.

To apply the value of an existing cell to a group of cells below it:

1. Ensure you are in Cell Selection mode.
2. Select the cell you want to copy.
3. Do one of the following to select the cells you want to change (all cells in a single selection must be contiguous):
   • Using the mouse, hold the Shift key and click the last cell in the group.
   • Using the keyboard, hold the Shift key and press the down arrow key to select cells.
4. Click the Actions menu, select Selection, and select Copy Down.

Tip:

You can also use the Selection Actions menu in the header row to quickly access several Selection submenu options (including Copy Down).

The first cell is copied to the cells selected below it.

You can also select cells in adjacent columns and use Copy Down to copy the value of the different cells in each column to cells below it (values do not copy across columns).

Tip:

Undo changes to the data by clicking Revert Changes in the Selection or Selection Actions menus.
2.7.4.5 Filling Cells in an Editable Interactive Grid

Apply a single value to a group of cells in an editable interactive grid by using Fill in the Actions, Selection submenu.

You can also apply a single value to all the cells in a row (or a group of rows) by using Fill in Row Selection mode.

To

1. Ensure you are in Cell Selection mode (select Actions menu and then Selection, or press F8).
2. Select the first cell of the group.
3. Press and hold the Shift key, and use the mouse or arrow keys to select a group of cells.

**Tip:**
All selected cells must be adjacent for a single Fill action. Repeat this procedure for non-adjacent cells.

4. Select the Actions menu, select Selection, and select Fill.
   The Fill Selection dialog displays.
5. Enter a value. Click OK.
   The entered value applies to the selected cells.

**Tip:**
Undo changes to the data by clicking Revert Changes in the Selection or Selection Actions menus.

2.7.4.6 Clearing Cells in an Interactive Grid

Delete the contents of multiple cells by using Clear in the Actions, Selection submenu.

You can also clear all of the cells in a row (or a group of rows) by using Fill in Row Selection mode.

To delete the contents of a group of adjacent cells:

1. Ensure you are in Cell Selection mode (select Actions menu and then Selection, or press F8).
2. Select the first cell of the group.
3. Press and hold the Shift key, and use the mouse or arrow keys to select a group of cells.
4. Select the **Actions** menu, select **Selection**, and select **Clear**.

The value of the selected cells is replaced with an empty text string.

You do not need to save the report because Clear directly affects the data in the database.

---

2.8 Saving Interactive Grids

Save your changes as a new report within the application. Name and keep these interactive grid reports Private or make them Public to share with other users.

- **About Interactive Grid Report Types**
  Reports in interactive grids have different uses and characteristics. You interact with the Primary report of an interactive grid, and save your changes as Private reports.

- **Saving a Report in an Interactive Grid**
  Save your changes to an interactive grid by clicking Save As in the Actions, Report submenu.

- **Renaming a Report in an Interactive Grid**
  Change the name of an interactive grid report by selecting Edit in the Actions, Report submenu.

- **Deleting a Report in an Interactive Grid**
  Delete a Private report from an interactive grid by selecting Delete in the Actions, Report submenu.

---

2.8.1 About Interactive Grid Report Types

Reports in interactive grids have different uses and characteristics. You interact with the Primary report of an interactive grid, and save your changes as Private reports.

The following is a list of default report types in Oracle Application Express, although developers can choose to add more:

**Private Report**
You can save a Private report of the interactive grid to preserve your changes to it (such as filters, aggregations, column order, visible columns, and other customizations).

Private reports can only be viewed by the user who creates them.
Primary Report
The default view of an interactive grid is the Primary report. While you can customize the look and organization of a Primary report, you cannot overwrite or rename it. The Primary report is useful as a backup or a starting point for customizing new views of the interactive grid.

After you save at least one private report, a drop-down list appears on the toolbar near the Search bar. You can use this to select between reports.

See Also:
"How the User Type Effects Available Save Options" in the Oracle Application Express App Builder User’s Guide

2.8.2 Saving a Report in an Interactive Grid

Save your changes to an interactive grid by clicking Save As in the Actions, Report submenu.

To save a Private interactive grid:
1. Click the Actions menu and select Report then Save As.

The Save As dialog displays.

2. In the Save As dialog:
   a. Type - Select Private.
   b. Name - Enter a name for the grid.

3. Click Save.

   Save further changes to the report by selecting Save in the Actions, Report Setting submenu.

   The report is saved and a confirmation message displays.
If there is now more than one saved report available in the interactive grid, a drop-down list appears on the toolbar between the Search Bar and Actions menu.

2.8.3 Renaming a Report in an Interactive Grid

Change the name of an interactive grid report by selecting Edit in the Actions, Report submenu.

To rename a report:
1. Select the report from the drop-down list.
2. Click the Actions menu and select Report then Edit.
   The Report Settings dialog displays.
3. Rename the report.

4. Click **Save**.

The report is saved.

2.8.4 Deleting a Report in an Interactive Grid

Delete a Private report from an interactive grid by selecting Delete in the Actions, Report submenu.

To delete an interactive grid report:

1. Select the report from the drop-down list.

2. Click the **Actions** menu and select **Report** then **Delete**.

A confirmation dialog appears.

3. Click **OK**.

The report is deleted and the Primary report reloads.

2.9 Resetting Interactive Grids

You can refresh, reset, or flashback a grid to revert your changes to it. Resetting an interactive grid can have different outcomes depending on the report type.

Refresh an interactive grid to update it with the most recent version of the data in the database. Reset an interactive grid to undo any changes since it was last saved. Flashback a grid to a point in the past (in minutes) to retrieve data from the database as it existed at that time, which ignores any changes made to the data in the database since that time.

- **Refreshing an Interactive Grid**
  Update an interactive grid with the most current data available on the database by selecting Refresh in the Actions, Data submenu.

- **Resetting an Interactive Grid**
  Undo changes to an interactive grid by clicking the Reset button or by selecting Reset from the Actions, Report submenu.

- **How the Reset Button Affects Saved Interactive Grid Reports**
  Clicking the Reset button reloads an interactive grid’s last saved state. The saved state varies between report types.

- **Reverting an Interactive Grid to a Specific Save State**
  Revert an interactive grid to a specific point in time by selecting the Flashback in the Actions, Data submenu.

2.9.1 Refreshing an Interactive Grid

Update an interactive grid with the most current data available on the database by selecting Refresh in the Actions, Data submenu.

Refreshing an interactive grid is quicker than reloading the entire page in the browser. Refreshing is also a valuable feature for highly fluid data sets.

To refresh an interactive grid:

1. Click the **Actions** menu and select **Data**.
2. Select **Refresh**.

The grid refreshes. Updates to the data are applied, but not marked.

### 2.9.2 Resetting an Interactive Grid

Undo changes to an interactive grid by clicking the Reset button or by selecting Reset from the Actions, Report submenu.

![Reset button](image)

**WARNING:**

Resetting an interactive grid reverts it to a previously saved state. Any changes since that time may be lost.

To reset an interactive grid, do one of the following:

- Click the **Reset** button.
- Click the **Actions** menu, select **Report**, and select **Reset**.

The grid reloads the last saved state.

### 2.9.3 How the Reset Button Affects Saved Interactive Grid Reports

Clicking the Reset button reloads an interactive grid’s last saved state. The saved state varies between report types.

In a Primary report, the **Reset** button undoes all changes that you have made—including reorganization and new content—because only developers can overwrite Primary reports. To preserve your changes, save a Private report.

In a Private report, the **Reset** button undoes only the changes that you have made since the last time you saved the report.
2.9.4 Reverting an Interactive Grid to a Specific Save State

Revert an interactive grid to a specific point in time by selecting the Flashback in the Actions, Data submenu.

To revert an interactive grid:
1. Click the Actions menu, select Data, and select Flashback.
   The Flashback dialog displays.
2. Enter the number of minutes into the past that you wish to return to.
3. Click Save.
   The grid reloads.

2.10 Downloading or Emailing an Interactive Grid

Obtain the data of an interactive grid as a CSV or HTML file by selecting Download in the Actions menu.

To download an interactive grid:
1. Click the Actions menu and select Download.
   The Download dialog displays.
2. Select CSV or HTML.
3. Do one of the following:
   • To download the file, click OK.
     Your browser downloads the file.
   • To email the file, select the check box Send as Email. Perform the following steps:
a. Complete the fields for the recipients (Address, Subject, Message).

b. Click **Send as Email**. The file is sent as an attachment to the email.
Using Interactive Reports

An interactive report is a formatted result of a SQL query.

- About Interactive Reports
  In addition to interactive grids, Oracle Application Express includes two main report types: an interactive report and a classic report.

- Accessing Interactive Reports
  An interactive report is contained in a page within a database application. To access an interactive report you must go to the database application URL, sign in using your account credentials (that is, your username and password), and then navigate to the report page.

- Using the Search Bar
  A search bar displays above interactive reports and includes the following features.

- Using the Select Columns To Search Icon
  The Select columns to search icon displays to the left of the search bar. Click this icon to display a listing of all columns in the current report.

- Using the Column Heading Menu
  Clicking a column heading in an interactive report displays the Column Heading menu. Positioning the cursor over each icon displays a tooltip that describes its function.

- Using Interactive Report Filters
  When you customize an interactive report, a filter displays between the search bar and the report.

- Customizing an Interactive Report Using the Actions Menu
  Customize an interactive report by selecting options on the Actions menu.

See Also:

"Managing Interactive Reports" in Oracle Application Express App Builder User’s Guide

3.1 About Interactive Reports

In addition to interactive grids, Oracle Application Express includes two main report types: an interactive report and a classic report.

The main difference between these two report types is that interactive reports enable you to customize the appearance of the data through searching, filtering, sorting, column selection, highlighting, and other data manipulations.
About Interactive Reports

The following is an example of an interactive report in the packaged application, Sample Reporting.

Interactive reports enable you to create highly customized reports. You can alter the report layout by hiding or exposing specific columns and applying filters, highlighting, and sorting. You can also define breaks, aggregations, charts, group data, and add their own computations. Once customized, the report can be saved as either a private or public report. Most interactive reports include a search bar, Actions menu, Column Heading menu, and edit icons in the first column of each row.

In contrast, classic reports support general keyword search capability, the ability to specify the number of rows that display, and basic column sorting.

See Also:
"Utilizing Packaged Applications" in Oracle Application Express App Builder User's Guide

3.2 Accessing Interactive Reports

An interactive report is contained in a page within a database application. To access an interactive report you must go to the database application URL, sign in using your account credentials (that is, your username and password), and then navigate to the report page.

- About Interactive Report URLs
  You can access interactive reports directly with their URL. Interactive report URLs contain an application ID and a page ID. When you access an application page, the session ID also generates in the address bar.
• Accessing an Interactive Report

Access an interactive report by navigating to the URL provided by your application developer. Ensure the URL includes the application ID and page ID, but not the session state ID.

3.2.1 About Interactive Report URLs

You can access interactive reports directly with their URL. Interactive report URLs contain an application ID and a page ID. When you access an application page, the session ID also generates in the address bar.

Parts of an Interactive Report URL

The following is an example of an Interactive Report URL:


f?p=
Indicates that you are accessing an Oracle Application Express application.

4350
The application ID. The application ID specifies which application to access.

1
The page ID. The page ID specifies which page to access within the application. Depending on how the developer configured the page, the page ID may be a word, such as home.

220883407765693447
The session ID. The Application Express engine uses the session ID to fetch session state from the database. Oracle Application Express assigns new session IDs during authentication processing, records the authenticated user's identity with the session ID, and continually checks the session ID in each page request's URL or POST data with the session cookie and the session record in the database.

⚠️ WARNING:

Do not enter the session ID when you access an interactive report URL. Entering information beyond the page ID displays an error.

✍️ See Also:

"About Session IDs" in Oracle Application Express App Builder User's Guide
3.2.2 Accessing an Interactive Report

Access an interactive report by navigating to the URL provided by your application developer. Ensure the URL includes the application ID and page ID, but not the session state ID.

If you do not have a URL or the URL does not work, contact the developer.

To access an interactive report:

1. Click the supplied URL, or enter it in your browser’s Address field.
   A Sign In page appears.
2. On the Sign In page:
   a. Username - Enter your username.
   b. Password - Enter your password.
   c. Click Sign In.

   The interactive report appears.

See Also:
"Understanding Session State Management" in Oracle Application Express
App Builder User’s Guide

3.3 Using the Search Bar

A search bar displays above interactive reports and includes the following features.

- Select columns to search icon - Resembles a magnifying glass. Click this icon to narrow your search to specific columns. To search all columns, select All Columns. See "Using the Select Columns To Search Icon."
- Text area - Enter case insensitive search criteria (wildcard characters are implied) and then click Go.
- Go button - Executes a search.
- View Report - Displays alternate default and saved private or public reports. See "Saving an Interactive Report."
- View icons - Switches between an icon, report and detail view of the default report (if enabled). May also include Chart and Group By View (if defined). Icons do not display by default, but must be configured by the developer.
- Actions menu - Use the Actions menu to customize an interactive report. See "Customizing an Interactive Report Using the Actions Menu."
3.4 Using the Select Columns To Search Icon

The Select columns to search icon displays to the left of the search bar. Click this icon to display a listing of all columns in the current report.

To search specific columns:
1. Click the **Select columns to search** icon and select a column.
2. Enter keywords in the Text area and click **Go**.
3. To disable the filter, select the **Enable/Disable Filter** check box.
4. To delete the filter, click the **Remove Filter** icon.

See Also:
“Selecting Columns to Display”

3.5 Using the Column Heading Menu

Clicking a column heading in an interactive report displays the Column Heading menu. Positioning the cursor over each icon displays a tooltip that describes its function.

Column Heading menu options include:
• Sort Ascending - Sorts the report by the column in ascending order.
• Sort Descending - Sorts the report by the column in descending order.
• Hide Column - Hides the column. Not all columns can be hidden. If a column cannot be hidden, the Hide Column icon does not display. To show a hidden column, select Reset from the Actions menu.
• Control Break - Creates a break group on the column. This pulls the column out of the report as a master record. See "Creating a Control Break."
• Column Information - Displays help text about the column, if available.
• Filter - Enter a case insensitive search criteria. Entering a value reduces the list of values at the bottom of the menu. You can then select a value from the bottom. The selected value will be created as a filter using either the equal sign (=) or contains depending on the List of Values Column Filter Type.

3.6 Using Interactive Report Filters

When you customize an interactive report, a filter displays between the search bar and the report.

The following illustration shows a report with two filters Project = 'Bug Tracker' and Status = 'On-Hold'. By default, filters display in the Report Settings area above the report. You can show or hide the filter details by clicking the arrow to the left of the filter name.

When you expand a filter and view the details, you can edit it as follows:

• **Enable/Disable** - To enable and disable a filter, select and deselect the check box to the left of the filter name.
• **Filter Edit** - To edit a filter, click the filter name.
• **Remove Filter** - To remove a filter, select the Remove Filter icon to the right of the filter name.
3.7 Customizing an Interactive Report Using the Actions Menu

Customize an interactive report by selecting options on the Actions menu.

**Tip:**
Not all options described in this section are available on every Actions menu. Developers can customize what options appear. To learn more, see "Customizing the Interactive Report Search Bar" in Oracle Application Express App Builder User's Guide.

- **About the Actions Menu**
The Actions menu appears to the right of the Go button on the Search bar. Use this menu to customize an interactive report.

- **Selecting Columns to Display**
Customize a report to include specific columns.

- **Adding a Filter**
Create row and column filters on an interactive report.

- **Selecting Column Sort Order**
You can specify column display sort order (ascending or descending) by selecting Sort on the Data submenu.

- **Creating a Control Break**
You can create a break group of one or several columns by selecting Actions, Format, and Control Break.

- **Adding Highlighting**
Customize the display to highlight specific rows in a report by selecting Highlight on the Actions, Format submenu.

- **Computing Columns**
Add mathematical computations (for example, \( \text{NBR\_HOURS/24} \)) or standard Oracle functions to columns.
• **Defining an Aggregation Against a Column**
  Define an aggregation against a column with the Actions, Data submenu. Aggregates are displayed after each control break and at the end of the report within the column for which they are defined.

• **Creating a Chart from the Actions Menu**
  Create charts in an interactive report with the Actions menu. You can create one chart for each interactive report. Once defined, you can switch between the chart and report views using buttons on the Search bar.

• **Grouping Columns**
  Group sets of results by one or more columns with Group By, then perform mathematical computations against the columns. Once you define the Group By, switch between the group by and report views using the View Icon on the Search bar.

• **Managing Pivot Reports**
  Pivot reports transpose rows into columns to generate results in a crosstab format.

• **Executing a Flashback Query**
  View the data as it existed at a previous point in time by executing a flashback query on the Actions, Data submenu.

• **Saving an Interactive Report**
  Save a private or public interactive report. Only the user who creates a private report can view, save, rename, or delete that private report.

• **Resetting a Report**
  Reset a report back to the default settings by selecting Reset from the Actions, Report submenu. Resetting a report removes any customizations you have made.

• **Downloading a Report**
  Download an interactive report by selecting Download from the Actions menu.

• **Subscribing to Report Updates by Email**
  Subscribe to an interactive report to receive updated versions it.
3.7.1 About the Actions Menu

The Actions menu appears to the right of the Go button on the Search bar. Use this menu to customize an interactive report.

**Actions Menu**

The Actions menu contains the following options:

- **Columns**
  Specifies which columns to display and in what order. See "Selecting Columns to Display."

- **Filter**
  Focuses the report by adding or modifying the filter clause on the query. See "Adding a Filter."

- **Data**
  Contains the Data submenu (see below).

- **Format**
  Contains the Format submenu (see below).

- **Chart**
  Displays the report data as a chart. See "Creating a Chart from the Actions Menu."

The Actions menu contains the following options:

**Columns**
Specifies which columns to display and in what order. See "Selecting Columns to Display."

**Filter**
Focuses the report by adding or modifying the filter clause on the query. See "Adding a Filter."

**Data**
Contains the Data submenu (see below).

**Format**
Contains the Format submenu (see below).

**Chart**
Displays the report data as a chart. See "Creating a Chart from the Actions Menu."
Group By
Enables users to group the result set by one or more columns and perform mathematical computations against columns. See “Grouping Columns.”

Pivot
Enables users to define a Pivot report. See "Managing Pivot Reports."

Report
Contains the Report submenu.
Manage your private and public reports of the interactive grid.
Saves the interactive report. Depending upon their user credentials, users can save different types of reports. See “Saving an Interactive Report.”
Revert the grid to its last saved state with the Reset function.

Reset
Resets the report back to the default report settings. See "Resetting a Report."

Download
Downloads a report. Available download formats depend upon your installation and report definition. See "Downloading a Report."

Subscription
Send an interactive report by email. See "Subscribing to Report Updates by Email."

Help
Provides descriptions of how to customize interactive reports.

Data Submenu
The Actions Menu also contains the Data submenu. The Data submenu contains the following options:

Sort
Changes the columns to sort on and determines whether to sort in ascending or descending order. See "Selecting Column Sort Order."

Aggregate
Enables users to perform mathematical computations against a column. See "Defining an Aggregation Against a Column."

Compute
Enables users to add computed columns to a report. See "Computing Columns."

Flashback
Enables users to view the data as it existed at a previous point in time. See "Executing a Flashback Query."

Format Submenu
The Actions Menu also contains the Format submenu. The Format submenu contains the following options:

Control Break
Creates a break group on one or several columns. This pulls the columns out of the interactive report and displays them as a master record. See "Creating a Control Break."
Highlight
Defines a filter that highlights the rows that meet the filter criteria. See "Adding Highlighting."

Rows Per Page
Select the number of rows that display per page.

3.7.2 Selecting Columns to Display

Customize a report to include specific columns.

To use the Select Columns option:

1. Click the Actions menu and select Columns.
   The Select Columns dialog appears.
2. Select the columns you want to move. Click the center arrows to move a column from Display in Report to Do Not Display. To select multiple columns at once, press and hold the CTRL key.
3. To change the order of the columns, click the Top, Up, Down, and Bottom arrows on the right.
4. Click Apply.
   A revised report appears.

See Also:
"Resetting a Report"

3.7.3 Adding a Filter

Create row and column filters on an interactive report.

- **About Creating Filters**
  You can create a filter on an interactive report by adding or modifying the WHERE clause on the query.

- **Adding, Editing, and Removing a Column Filter**
  Use the Actions menu to add, edit, or remove a column filter in an interactive report.

- **Adding, Editing, and Removing a Row Filter**
  Use the Actions menu to add, edit, or remove a row filter in an interactive report.

3.7.3.1 About Creating Filters

You can create a filter on an interactive report by adding or modifying the WHERE clause on the query.

You can create two types of filters:

- **Column** - Creates a custom column filter. Select a column, select a standard Oracle operator (=, ! =, not in, between), and enter an expression to compare
against. Expressions are case sensitive. Use the percent sign (%) as a wildcard. Note that the selected column does not need to be one that currently displays. For example:

\[ \text{STATE\_NAME}\ LIKE\ A% \]

- **Row** - Creates a custom row filter. This filter creates a complex WHERE clauses using column aliases and any Oracle functions or operators. For example:

\[ G = 'VA'\ OR\ G = 'CT' \]

Where \( G \) is the alias for CUSTOMER\_STATE.

### 3.7.3.2 Adding, Editing, and Removing a Column Filter

Use the Actions menu to add, edit, or remove a column filter in an interactive report.

To add a column filter:

1. Click the **Actions** menu and select **Filter**.
   
The Filter dialog appears.
2. For Filter Type, select **Column**.
3. In the Filter region, specify a column, an operator, and an expression and click **Apply**.

Notice the filter that displays in the Report Settings area above the report. You can show or hide the filter details by clicking the arrow to the left of the filter name.

To revise the filter:

4. Click the filter name (in this example, `Project = 'Discussion Forum'`).
5. Edit your selections and click **Apply**.
6. To disable the filter, select the **Enable/Disable Filter** check box.
7. To delete the filter, click **Remove Filter**.
3.7.3.3 Adding, Editing, and Removing a Row Filter

Use the Actions menu to add, edit, or remove a row filter in an interactive report.

To add a row filter:

1. Click the **Actions** menu and select **Filter**.
   The Filter dialog appears.
2. For Filter Type, select **Row**.
3. In the Filter dialog:
   a. **Name** - Enter a name that describes this filter.
   b. **Filter Expression** - Enter an expression. Select a column and function or operator at the bottom of the region. For example, \( I \geq 2500 \) displays projects costing more than $5000.
   c. Click **Apply**.

Notice the filter that displays in the Report Settings area above the report. You can show or hide the filter details by clicking the arrow to the left of the filter name.

4. To revise the filter:
   a. Click the filter name.
   b. Edit your selections and click **Apply**.
5. To disable the filter, select the **Enable/Disable Filter** check box.
6. To delete the filter, click **Remove Filter**.

3.7.4 Selecting Column Sort Order

You can specify column display sort order (ascending or descending) by selecting Sort on the Data submenu.

You can also specify how to handle **NULL** values. Using the default setting always displays **NULL** values last or always displays them first.

To sort by column:

1. Click the **Actions** menu and select **Data** and then **Sort**.
   The Sort dialog appears.
2. Select a column, the sort direction (**Ascending** or **Descending**), and Null Sorting behavior (**Default**, **Nulls Always Last**, or **Nulls Always First**).
3. Click **Apply**.

3.7.5 Creating a Control Break

You can create a break group of one or several columns by selecting Actions, Format, and Control Break.

Creating a break group pulls the columns out of the interactive report and displays them as a master record.
To create a break group:

1. Click the Actions menu and select Format and then Control Break. The Control Break dialog appears.
2. Select a column and then a status (Enable or Disable).
3. Click Apply. A revised report displays.

4. Click the left arrow to expand the filter.
5. To disable the Control Break filter, deselect the Enable/Disable Filter check box. To activate a disabled filter, select the Enable/Disable Filter check box again.
6. To delete the filter, click Remove Control Break.

3.7.6 Adding Highlighting

Customize the display to highlight specific rows in a report by selecting Highlight on the Actions, Format submenu.

To add highlighting:

1. Click the Actions menu and select Format and then Highlight. The Highlight dialog appears.
2. Edit the following information:
   a. Name - Enter a name that describes this filter.
   b. Sequence - Enter a numeric value to identify the sequence in which highlighting rules are evaluated.
   c. Enabled - Select Yes.
d. Highlight Type - Select **Cell** or **Row**.

e. Background Color - Select a new color for the background of the highlighted area.

f. Text Color - Select a new color for the text in the highlighted area.

g. Highlight Condition - Select a column, an operator, and expression.

h. Click **Apply**.

---

**Highlight**

<table>
<thead>
<tr>
<th>Name</th>
<th>On-Hold Projects</th>
</tr>
</thead>
<tbody>
<tr>
<td>Sequence</td>
<td>10</td>
</tr>
<tr>
<td>Enabled</td>
<td>Yes</td>
</tr>
<tr>
<td>Highlight Type</td>
<td>Row</td>
</tr>
<tr>
<td>Background Color</td>
<td>[yellow] [green] [blue] [orange] [red]</td>
</tr>
<tr>
<td>Text Color</td>
<td>#FF7755</td>
</tr>
<tr>
<td>Highlight Condition</td>
<td>Column</td>
</tr>
<tr>
<td>Status</td>
<td>Status</td>
</tr>
</tbody>
</table>

---

**On-Hold Projects**

<table>
<thead>
<tr>
<th>Project</th>
<th>Task Name</th>
<th>Start Date</th>
<th>End Date</th>
<th>Status</th>
<th>Assigned To</th>
<th>Cost</th>
</tr>
</thead>
<tbody>
<tr>
<td>Train Developers in APEX</td>
<td>Publish links to self-study courses</td>
<td>24-JAN</td>
<td>24-JAN</td>
<td>Closed</td>
<td>John Watson</td>
<td>100</td>
</tr>
<tr>
<td>Train Developers in APEX</td>
<td>Publish development standards</td>
<td>21-JAN</td>
<td>29-MAR</td>
<td>On-Hold</td>
<td>John Watson</td>
<td>1000</td>
</tr>
<tr>
<td>Train Developers in APEX</td>
<td>Create training workspace</td>
<td>24-JAN</td>
<td>31-JAN</td>
<td>Closed</td>
<td>James Cassidy</td>
<td>500</td>
</tr>
<tr>
<td>Software Projects Tracking</td>
<td>Load current tasks and enhancements</td>
<td>04-FEB</td>
<td>08-FEB</td>
<td>Closed</td>
<td>Tom Suess</td>
<td>400</td>
</tr>
<tr>
<td>Software Projects Tracking</td>
<td>Enter base data (Projects, Milestones, etc.)</td>
<td>02-FEB</td>
<td>03-FEB</td>
<td>Closed</td>
<td>Tom Suess</td>
<td>200</td>
</tr>
<tr>
<td>Software Projects Tracking</td>
<td>Customize Software Projects software</td>
<td>07-FEB</td>
<td>15-MAR</td>
<td>Open</td>
<td>Tom Suess</td>
<td>600</td>
</tr>
</tbody>
</table>
Tip:

Note the highlight On-Hold Projects displays in the Report Settings area above the report. You can show or hide the filter details by clicking the arrow to the left of the filter name.

3. To revise the highlight, click the highlight name and make the following edits:
   a. Background Color - Select yellow.
   b. Text Color - Select red.
   c. Click Apply.

4. To disable the highlight, select the Enable/Disable check box.

5. To delete the highlight, click Remove Highlight.

3.7.7 Computing Columns

Add mathematical computations (for example, NBR_HOURS/24) or standard Oracle functions to columns.

- Creating a Computation
  Use the Compute function in the Actions, Data submenu to add a computation to a column.

- Deleting a Computation
  Open the Compute dialog to remove a computation.

3.7.7.1 Creating a Computation

Use the Compute function in the Actions, Data submenu to add a computation to a column.

To create a computation:

1. Click the Actions menu and select Data and then Compute.
   The Compute dialog appears.

2. In the Compute dialog:
   b. Column Label - Enter the name of the new column to be created.
   c. Format Mask - Select an Oracle format mask to be applied to the new column.
      (For example, $5,234.10).

3. Create the computation:
   a. Columns - Select a column or alias.
   b. Keypad - Select a shortcut for commonly used keys.
   c. Functions - Select the appropriate function.

In the following example, a new column compares the actual cost to the budgeted amount, using the formula \( I - H \), where \( I \) is the budgeted amount and \( H \) is the cost.

4. Click Apply.
The revised report appears containing a new Cost Analysis column.

### 3.7.7.2 Deleting a Computation

Open the Compute dialog to remove a computation.

To delete a computation:

1. Click the **Actions** menu and select **Data** and then **Compute**.
   
   The Compute dialog appears.

2. From Computation, select the computation.
   
   The computation appears.

3. Click **Delete**.

### 3.7.8 Defining an Aggregation Against a Column

Define an aggregation against a column with the Actions, Data submenu. Aggregates are displayed after each control break and at the end of the report within the column for which they are defined.

- **Creating an Aggregation Against a Column**
  Create an aggregation by selecting Aggregate in the Actions, Data submenu.

- **Removing a Column Aggregation**
  Open the Aggregate dialog to remove an aggregation.

### 3.7.8.1 Creating an Aggregation Against a Column

Create an aggregation by selecting Aggregate in the Actions, Data submenu.

To create an aggregation against a column:

1. Click the **Actions** menu and select **Data** and then **Aggregate**.
   
   The Aggregate dialog appears.

2. In the Aggregate dialog:
   
   a. Aggregation - Select **New Aggregation**.
b. Function - Select one of the following: **Sum; Average, Count, Count Distinct, Minimum, Maximum, or Median**.

c. Column - Select a column.

![Aggregate dialog](aggregate_dialog.png)

This example creates a sum of the Cost column.

d. Click **Apply**.

![Report example](report_example.png)

The computation appears at the bottom of the last page of the report. In this example, the aggregate shows the sum of all amounts in the Cost column.

### 3.7.8.2 Removing a Column Aggregation

Open the Aggregate dialog to remove an aggregation.

To remove column aggregation:

1. Click the **Actions** menu and select **Data** and then **Aggregate**.
   
The Aggregate dialog appears.

2. From Aggregation, select a previously defined aggregation.

3. Click **Delete**.
3.7.9 Creating a Chart from the Actions Menu

Create charts in an interactive report with the Actions menu. You can create one chart for each interactive report. Once defined, you can switch between the chart and report views using buttons on the Search bar.

- **Creating a Chart**
  Use the Chart function in the Actions menu to create a chart in an interactive report.

- **Editing a Chart**
  Open the Chart dialog to edit a chart in an interactive report.

- **Deleting a Chart**
  Open the Chart dialog to remove a chart in an interactive report.

3.7.9.1 Creating a Chart

Use the Chart function in the Actions menu to create a chart in an interactive report.

To create a chart:

1. Click the **Actions** menu and select **Chart**.
   The Chart dialog appears.

2. In the Chart dialog, specify the appropriate options.
   a. **Chart Type** - Select the type of chart you want to create (horizontal bar, vertical bar, pie, or line).
   b. **Label** - Select the column to be used as the label.
   c. **Axis for Title for Label** - Enter the title to display on the axis associated with the column selected for Label (not available for pie chart).
   d. **Value** - Select the column to be used as the Value. If your function is a **COUNT**, a Value does not need to be selected.
   e. **Axis Title for Value** - Enter the title to display on the axis associated with the column selected for Value (not available for pie chart).
   f. **Function** - (Optional) Select a function to be performed on the column selected for Value.
   g. **Orientation** - Select whether chart elements extend up and down or sideways. (Not applicable for pie charts.)
   h. **Sort** - Select a sorting method.

3. Click **Apply**.
   The chart appears.

**Tip:**

The Search bar now contains two icons: **View Report** and **View Chart**. Click these icons to toggle between chart and report views.
3.7.9.2 Editing a Chart

Open the Chart dialog to edit a chart in an interactive report.

To edit a chart:
1. While viewing a report:
   a. Click the Actions menu and select Chart.
      The Chart dialog appears.
   b. Edit your selections and click Apply.
2. While viewing a chart:
   a. Click Edit Chart.
   b. Edit your selections and click Apply.

3.7.9.3 Deleting a Chart

Open the Chart dialog to remove a chart in an interactive report.

To delete a chart:
1. While viewing a report:
   a. Click the Actions menu and select Chart.
      The Chart dialog appears.
   b. Click Delete.
2. While viewing a chart:
   a. Click Edit Chart.
   b. Click Delete.

Tip:
You can also click the Remove Chart icon to the right of the Edit Chart filter.

3.7.10 Grouping Columns

Group sets of results by one or more columns with Group By, then perform mathematical computations against the columns. Once you define the Group By, switch between the group by and report views using the View Icon on the Search bar.

- Creating a Group By
  Use the Group By function in the Actions menu to reorganize an interactive grid.

- Editing a Group By
  Edit the properties of a grouping in the Group By dialog.

- Selecting a Group By Sort Order
  Specify group by column sort order (ascending or descending) by either clicking on the group by column heading or selecting Group By Sort on the Data submenu.
3.7.10.1 Creating a Group By

Use the Group By function in the Actions menu to reorganize an interactive grid.

To use Group By:

1. Click the Actions menu and select Group By.
   The Group By dialog appears.
2. In the Group by dialog:
   a. Select a column to display. To add additional columns, click Add Group By Column.
   b. Select the function, column, label, and format mask. To create a sum, click the Sum check box. To add another function, click Add Function.
   c. Click Apply.
A Group By icon appears to the left of the Actions menu. The resulting report displays the Project, Task Name, and Budget columns. Additionally, a new column, Total Cost, displays on the right side.

### 3.7.10.2 Editing a Group By

Edit the properties of a grouping in the Group By dialog.

To edit a group by:
1. Click **Edit Group By**. The Group By dialog appears.
2. Edit the attributes.
3. To remove a previously defined Group by Column, select the default setting **Select Group By Column**.
4. Click **Apply**.

### 3.7.10.3 Selecting a Group By Sort Order

Specify group by column sort order (ascending or descending) by either clicking on the group by column heading or selecting Group By Sort on the Data submenu.

You can also specify how to handle NULL values. Using the default setting always displays NULL values last or always displays them first.

To sort a group by column:
1. Access a Group By view.
2. Click the **Actions** menu, select **Data**, and select **Group By Sort**.

**Tip:**
- The Group By Sort menu is only visible when you are viewing Group By view.

The Group By Sort dialog appears.
3. Select a column, the sort direction (Ascending or Descending), and Null Sorting behavior (Default, Nulls Always Last, or Nulls Always First).
4. Click **Apply**.

**See Also:**
- Creating a Group By

### 3.7.10.4 Deleting a Group By

Delete a grouping in the Group By dialog.
To delete a group by:

1. Click **Edit Group By**.
   The Group By dialog appears.
2. Click **Delete**.

Tip:
You can also click the Remove Group By icon to the right of the Edit Group By filter.

### 3.7.11 Managing Pivot Reports

Pivot reports transpose rows into columns to generate results in a crosstab format.

Select pivot columns and rows and then provide the functions to be represented in the pivot report. Once created, pivot reports display a new icon in the search bar.

- **Creating a Pivot Report**
  Create a pivot report by opening the Pivot dialog from the Actions menu.

- **Editing a Pivot Report**
  Edit a pivot report by clicking the Edit Pivot filter in an interactive report and opening the Pivot dialog.

- **Deleting a Pivot Report**
  Remove a pivot report from an interactive report in the Pivot dialog.

#### 3.7.11.1 Creating a Pivot Report

Create a pivot report by opening the Pivot dialog from the Actions menu.

To create a pivot report:

1. Click the **Actions** menu and select **Pivot**.
   The Pivot dialog appears.

2. In the Pivot dialog:
   a. **Pivot Columns** - Select the columns to display (for example, **Status**). To add additional columns, click **Add Pivot Column**.
   b. **Row Columns** - Select the rows to display (for example, **Project**). To add additional columns, click **Add Row Column**.
   c. **Computation**:
      - Select a function, column, label, and format mask.
      - To create a sum, click the **Sum** check box (optional).
   d. Click **Apply**.

The Search Bar now contains two icons: View Report and View Pivot. Click these icons to toggle between the report view and the pivot view.

The following example shows a Pivot report that displays the number of closed, on-hold, open, and pending tasks associated with each project.
3.7.11.2 Editing a Pivot Report

Edit a pivot report by clicking the Edit Pivot filter in an interactive report and opening the Pivot dialog.

To edit a pivot report:

1. Click the **Edit Pivot** filter.
   
The Pivot dialog appears.

2. Edit the attributes.

3. To remove a previously defined column or row, select the default setting, **Select Pivot Column** and **Select Row Column**.

4. Click **Apply**.

3.7.11.3 Deleting a Pivot Report

Remove a pivot report from an interactive report in the Pivot dialog.

To delete a pivot report:

1. Click the **Edit Pivot** filter.
   
The Pivot dialog appears.

2. **Delete**.

   **Tip:**

   You can also click the **Remove Pivot** icon to the right of the Edit Pivot filter.
3.7.12 Executing a Flashback Query

View the data as it existed at a previous point in time by executing a flashback query on the Actions, Data submenu.

The default amount of time that you can flashback is 3 hours (or 180 minutes) but the actual amount is different for each database.

- **Creating a Flashback Query**
  Create a flashback query by using the Actions, Data submenu.
- **Editing a Flashback Query**
  Edit a flashback query by clicking the flashback query filter in an interactive report.
- **Deleting a Flashback Query**
  Delete a flashback query by using the flashback query filter dialog in an interactive report.

3.7.12.1 Creating a Flashback Query

Create a flashback query by using the Actions, Data submenu.

To execute a flashback query:
1. Click the **Actions** menu and select **Data** then **Flashback**.
2. In the Flashback field, enter the number of minutes.
3. Click **Apply**.

3.7.12.2 Editing a Flashback Query

Edit a flashback query by clicking the flashback query filter in an interactive report.

To edit a flashback query:
1. Click **flashback query** filter.
   
   The Flashback dialog appears.
2. Edit minute ago attribute.
3. Click **Apply**.

3.7.12.3 Deleting a Flashback Query

Delete a flashback query by using the flashback query filter dialog in an interactive report.

To delete a flashback query:
1. Click the **flashback query** filter.
   
   The Flashback dialog appears.
2. Click **Delete**.
3.7.13 Saving an Interactive Report

Save a private or public interactive report. Only the user who creates a private report can view, save, rename, or delete that private report.

- **About the Report List**
  You can view different versions of an interactive report by selecting from a drop-down list of default or primary reports and private reports.

- **About Configuration Dependencies**
  The ability to save an interactive report is configurable by the application developer who creates the interactive report.

- **Saving a Public or Private Interactive Report**
  End users can save an interactive report and classify it as Public or Private.

- **Renaming a Public or Private Interactive Report**
  Rename a public or private report that you have created by clicking its report name.

- **Deleting a Public or Private Interactive Report**
  Remove a public or private report that you have created by clicking its Remove Report icon.

3.7.13.1 About the Report List

You can view different versions of an interactive report by selecting from a drop-down list of default or primary reports and private reports.

The following illustration shows the Reports list on the Search bar of an interactive report.

![Reports list illustration](image)

This example shows two reports:
Default - Primary Report
This is the initial report created by the application developer. Default, Primary reports cannot be renamed or deleted.

Private - 1. Open Projects
This is a Private report. Only the user who creates a private report can view, save, rename, or delete it.

3.7.13.2 About Configuration Dependencies
The ability to save an interactive report is configurable by the application developer who creates the interactive report.

See Also:
- “Customizing the Interactive Report Search Bar” in Oracle Application Express App Builder User’s Guide
- “Saving Interactive Report” in Oracle Application Express App Builder User’s Guide

3.7.13.3 Saving a Public or Private Interactive Report
End users can save an interactive report and classify it as Public or Private.

Public
The report can be saved, renamed, or deleted by the end user who created it. Other users can view and save the layout as another report.

Private
Only the end user that created the report can view, save, rename or delete the report.

To save a public or private interactive report:
1. Go to the page containing the interactive report you want to save.
2. Customize the report (for example, hide columns, add filters, and so on).
3. Click the Actions menu and select Report then Save Report. The Save Report dialog appears.

The Save Report dialog appears.

Save Report  
Save: As Named Report ▼  
Name:  
Description:  
Public  
(Only displayed for developers)
4. In Save Report:
   a. Select either **As Named Report** or **As Default Report Settings** option.
   
   **Tip:**
   This option is available for only developers.
   
   b. **Name** - Enter a name for the report.
   c. **Description** - Enter an optional description.
   d. **Public** - Select this check box to make the report viewable to all users.
      Deselect this check box to make the report private.
   
   **Tip:**
   The ability to save an interactive report as Public is determined by your application developer.
   
   e. Click **Apply**.

---

### See Also:

- Customizing an Interactive Report Using the Actions Menu
- About Configuration Dependencies

---

### 3.7.13.4 Renaming a Public or Private Interactive Report

Rename a public or private report that you have created by clicking its report name.

To rename a public or private interactive report:

1. Select a public or private interactive report to rename.
2. Click the Saved Report filter which displays between between the search bar and the report.
3. In the Rename Report dialog, edit the attributes (for example, enter a new name).
4. Click **Apply**.

### 3.7.13.5 Deleting a Public or Private Interactive Report

Remove a public or private report that you have created by clicking its Remove Report icon.

To delete a public or private interactive report:

1. Click the **Remove Report** icon next to the report name link.
3.7.14 Resetting a Report

Reset a report back to the default settings by selecting Reset from the Actions, Report submenu. Resetting a report removes any customizations you have made.

To reset a report:
1. Click the Actions menu and select Report then Reset.
2. Click Apply.

3.7.15 Downloading a Report

Download an interactive report by selecting Download from the Actions menu. Available download formats depend upon your installation and report definition. Supported formats include comma-delimited file (CSV) format, HTML, Email, Microsoft Excel (XLS) format, Adobe Portable Document Format (PDF), and Microsoft Word Rich Text Format (RTF).

To download a report:
1. Click the Actions menu and select Download.
2. Select a report download format and follow the provided instructions.

**Tip:**

The ability to download an interactive report is configurable by your application developer.

**See Also:**

“Configuring Actions Menu Download Options” in Oracle Application Express App Builder User’s Guide
3.7.16 Subscribing to Report Updates by Email

Subscribe to an interactive report to receive updated versions it.

- **How Report Subscriptions Work**
  You can subscribe to a report by clicking Subscription on the Actions menu.

- **Subscribing to Updated Report Results**
  Subscribe to a report by selecting Subscription in the Actions menu.

### See Also:
"Managing Interactive Report Subscriptions" in *Oracle Application Express Administration Guide*

3.7.16.1 How Report Subscriptions Work

You can subscribe to a report by clicking Subscription on the Actions menu.

Emails sent from an interactive report contain a system generated email signature that cannot be overwritten that identifies who originated the email.

To use Subscription:

- An Oracle Application Express administrator must configure email at the Instance level.
- The application developer must select the report Attributes and enable the Actions Menu, Subscription attribute.

### See Also:
"Customizing the Action Menu" in *Oracle Application Express App Builder User’s Guide*

3.7.16.2 Subscribing to Updated Report Results

Subscribe to a report by selecting Subscription in the Actions menu.

### Note:
Emails sent from a subscription include a system generated email signature indicating who created the subscription. This signature cannot be removed.

To receive updated report results by email:

1. Click the **Actions** menu and select **Subscription**.
The Subscription dialog appears.

2. **Under Subscription:**
   
   a. **Email Address** - Enter the email addresses to receive the report. To include multiple email addresses, separate each email address with a comma.

   b. **Subject** - Enter text to display in the email subject line.

   c. **Frequency** - Select the interval at which the report is sent.

   d. **Starting From** - Select a start date and time.

   e. **Ending** - Select an end date and time. Select a day, week, month, or year.

   f. Click **Apply**.
Data Loading Wizard Examples

You can import data into an Oracle Application Express application using an existing application Data Loading Wizard.

Tip:
To use the functionality described in this section, your application must be built with Data Upload capability. To learn more, see "Creating Applications with Data Loading Capability" in Oracle Application Express App Builder User's Guide.

• About Using the Data Loading Wizard
You can run a Data Load Wizard to upload data from a file or copy and paste data that you have entered directly into the wizard.

• Importing Data from a File into Your Application
Use the Data Load Wizard to import data into your application from a file, such as a text file.

• Copying and Pasting Data into Your Application
Use the Data Load wizard to copy and paste data from a file, such as a text file.

4.1 About Using the Data Loading Wizard

You can run a Data Load Wizard to upload data from a file or copy and paste data that you have entered directly into the wizard.

Applications with data loading capability enables you to directly import data into a table which has been configured by the application developer.

The Data Loading wizard for your application may have been built to include the ability to apply table lookup and transformation rules during the data upload process. Before the data is actually imported into the database, you can preview the data after all look up and transformation rules have been applied.

• Table Lookups - These rules automatically map data in the import file or copy and paste field to data that is found in another table. For example, if the import file contains a department name for the DEPTNO column but the upload table requires a number for that column, use a table lookup rule to find the corresponding department number for that department name in another table.

• Data transformation rules - These rules automatically perform formatting transformations such as changing import data to uppercase, lowercase, and so on. For example, if the import file includes column data with both upper and lowercase and the destination table requires all uppercase, data transformation rules can automatically insert only uppercase into that column during data upload.
4.2 Importing Data from a File into Your Application

Use the Data Load Wizard to import data into your application from a file, such as a text file.

This procedure includes examples from the sample packaged application, Sample Database Application.

To upload data to your application, the application must have been built with Data Upload capability and the file must be formatted properly.

To upload data from a file:

1. Run the sample packaged application, Sample Database Application.
2. On the Customers page, click Upload Data.
   The Data Load wizard appears. Next, select how to upload data.
3. For Import From, select Upload file, comma separated (*.csv) or tab delimited.

Choose the Import From of "Copy and Paste", input Separator as ",", and ensure the First Row has Column Names is checked.

Click here to copy and paste, or select the text below and paste it into the Copy and Paste Delimited Data section.

First Name,Last Name,Street Address,City,State,Postal Code,Email,Phone Number,Alternate Number,Credit Limit,Tags
John,Dulles,5987 Whitehart Lane,Chicago,Illinois,60666,john.dulles@esilen.com,312-666-5987,728-666-1234,4800
New Address
Peter,Williams,1212 TechnoCozy Way,Denver,Colorado,80227,303-555-6688,1590
Susan,Peters,9000 Reston Parkway,Reston,Virginia,20191,susan.peters@gmail.com,703-909-5627,703-123-9876,2500
Albert,Lambert,2460 Longridge Place,St. Louis,Missouri,63149,314-000-1000,3330,New Address
Bob,Uncle,888 Mason St,San Francisco,California,94110,bob.uncle@email.com,2000

4. Under Data Load Source:
   a. File Name - Browse to the file name containing the data to upload.
Tip:

To create a text file with sample data, copy and paste the data shown at the top of the page into a text file. If you use this sample data, remember to enter a comma (,) in the Separator attribute.

b. Separator - Enter the column separator character. Enter a comma (,) for comma separators or \t for tab separators.

c. Optionally Enclosed By - Enter a delimiter character.

Use this character to delineate the starting and ending boundary of a data value. If you specify a delimiter character, Data Workshop ignores whitespace occurring before the starting and ending boundary of a data value. You can also use this option to enclose a data value with the specified delimiter character.

d. First Row has Column Names - Select this option if your data contains column names in the first row.

e. Optionally select Use Advanced Settings and configure the following attributes:

- Decimal Character - Enter a decimal character to separate the integer and decimal parts of a number. To learn more, see field-level Help.
- Group Separator - Enter a group separator to separate integer groups. Any non-numeric character can function as the group separator with a few exceptions. To learn more, see field-level Help.
- Currency Symbol - If your data contains an international currency symbol, enter it here. See field-level Help for examples.
- File Character Set - Select the file character set associated with the file to be uploaded.
- Date / Number Formats to use - Select Use application standard format masks to use the Application Date and Timestamp formats during data loading or Provide custom formats for uploaded columns to input your own.

f. Click Next.

The Data/Table Mapping page appears.
5. For Data/Table Mapping:
   a. Target Column - Indicates the destination column name. To change the column name, select a new column name from the list. To hide a column, select Do Not Load.
   b. Click Next.

   The Data Validation page appears showing the data to be inserted or updated after any table lookup and transformation rules have been applied.

6. Review the data to be uploaded and click Load Data.

   The Data Load Results page displays:
   • Inserted Row(s) - This is the number of new rows uploaded to the table.
   • Updated Row(s) - This is the number of rows in the table updated with new information.
4.3 Copying and Pasting Data into Your Application

Use the Data Load wizard to copy and paste data from a file, such as a text file.

This procedure includes an example from the sample packaged application, Sample Database Application.

To upload data to your application, the application must have been built with Data Upload capability and the pasted data must be formatted properly.

To upload data by copying and pasting:
1. Run the sample packaged application, Sample Database Application.
2. On the Customers page, click Upload Data.
   The Data Load wizard appears. Next, select how to upload data.
3. From Import From, select Copy and Paste.

- Failed Row(s) - This is the number of rows from the upload file that were not added or updated.
- To be Reviewed Row(s) - This is the number of rows needing review.

7. Click Finish.

See Also:
- "About Using the Data Loading Wizard"
- "Understanding Sample Database Application" in Oracle Application Express App Builder User's Guide
- "Utilizing the App Gallery" in Oracle Application Express App Builder User's Guide
- "Configuring Globalization Attributes" in Oracle Application Express App Builder User's Guide
4. Under Data Source Load:
   a. Copy and Paste Delimited Data - Copy the example comma-separated list shown in the Data Load Source dialog (First Name, Last Name, Street ...), and paste it here.
   b. Separator - Enter the column separator character. Enter a comma (,) for comma separators or \t for tab separators.
   c. Optionally Enclosed By - Enter a delimiter character. Use this character to delineate the starting and ending boundary of a data value.
   d. First Row has Column Names - Select this option if your data contains column names in the first row.
   e. Optionally select **Use Advanced Settings** and configure the following attributes:
      - Decimal Character - Enter a decimal character to separate the integer and decimal parts of a number.
      - Group Separator - Enter a group separator to separate integer groups. Any non-numeric character can function as the group separator with a few exceptions.
      - Currency Symbol - If your data contains an international currency symbol, enter it here.
      - File Character Set - Select the file character set associated with the file to be uploaded.
      - Date / Number Formats to use - Select **Use application standard format masks** to use the Application Date and Timestamp formats during data loading or **Provide custom formats for uploaded columns** to input your own.
f. Click Next.
The Data/Table Mapping page appears.

5. For Data/Table Mapping:
   a. Target Column - Indicates the destination column name. To change the column name, select a new column name from the list. To hide a column, select Do Not Load.
   b. Click Next.
      The Data Validation page appears showing the data that to be inserted or updated after any table lookup and transformation rules have been applied.
6. For Data Validation, review the data to be uploaded and click **Load Data**.

The Data Load Results page shows:

- **Inserted Row(s)** - This is the number of new rows uploaded to the table.
- **Updated Row(s)** - This is the number of rows in the table updated with new information.
- **Failed Row(s)** - This is the number of rows from the upload file that were not added or updated.
- **To be Reviewed Row(s)** - This is the number of rows needing review.

7. Click **Finish**.

---

### See Also:

- "About Using the Data Loading Wizard"
- "Understanding Sample Database Application" in *Oracle Application Express App Builder User’s Guide*
- "Utilizing the App Gallery" in *Oracle Application Express App Builder User’s Guide*
- "Configuring Globalization Attributes" in *Oracle Application Express App Builder User’s Guide*
Using Websheets

User interface elements common to all Websheets include breadcrumb sections, navigation sections, online help, search, and the Websheet control panel.

- **About Websheet Applications**
  Websheet applications are interactive web pages that combine text with data. You can define these highly dynamic applications in a number of ways.

- **Accessing Websheets**
  Users access a Websheet by loading the Websheet URL, signing in with their account credentials (username and password), and navigating to the Websheet page.

- **Using Websheets**
  The Websheet application interface contains various elements for quick navigation and robust text editing.

- **Managing Websheet Pages**
  You can add pages to a Websheet manually or copy existing pages.

- **Adding and Editing Page Sections**
  You can add new sections to a Websheet page with the Create menu and edit existing sections with the Edit button and Edit menu.

- **Adding and Editing Text Sections**
  You can create a Text section to add text to a Websheet page. You can type directly into a text section, or copy and paste content from a spreadsheet.

- **Adding a Navigation Section**
  Add dynamically generated navigation to subordinate pages or page sections by clicking New Section in the Create menu and create a Navigation section.

- **Managing Data Grids**
  Data grids are sets of data displayed in rows and columns. Data grids store data in a similar way to how spreadsheets store data. Once created, the structure can be modified as needed over time.

- **Adding and Editing Data Content**
  Add content to Websheets that is queried from your Oracle Database (such as data grids and reports). Note: this function requires your application’s developer to enable the Allow SQL attribute.

- **Adding Data Reports**
  Data reports are contributor defined queries on tables or views within the underlying Oracle Database.

- **Creating Data Sections Based on a Data Grid or Report**
  Add a data grid or data report to a Websheet with data sections.

- **Creating Chart Sections**
  You can create inline charts based upon a data grid or report.
• **Understanding Markup Syntax**
  You can use the following syntax for adding links to Websheet pages, page sections, external URLs, data grids, or for including SQL or SQLVALUE syntax.

• **Managing Annotations**
  Add commentary and additional details to a web sheet in annotations.

• **Managing Websheet Applications**
  From a Websheet, you can change your Websheet password, email a Websheet to another user, and print a Websheet.

• **Viewing Websheets**
  Use the options on the View menu to access presentation mode, view a page directory, access a page history, and view an application directory.

---

**See Also:**

"Creating Websheet Applications" in *Oracle Application Express App Builder User’s Guide*

---

### 5.1 About Websheet Applications

Websheet applications are interactive web pages that combine text with data. You can define these highly dynamic applications in a number of ways.

Websheet applications include navigation controls, search capabilities, and the ability to add annotations such as files, notes, and tags. Websheet applications can be secured using access control lists and several built-in authentication models.

---

**See Also:**

"Using Websheets"

---

### 5.2 Accessing Websheets

Users access a Websheet by loading the Websheet URL, signing in with their account credentials (username and password), and navigating to the Websheet page.

• **About Websheet URLs**
  Websheet URLs contain an application ID and a page ID. When you access a Websheet, the session ID also generates in the address bar.

• **Accessing a Websheet**
  To access a Websheet, the Websheet developer provides you a URL and login credentials (that is, a username and password). Ensure the URL includes the application ID and page ID, but not the session state ID.
5.2.1 About Websheet URLs

Websheet URLs contain an application ID and a page ID. When you access a Websheet, the session ID also generates in the address bar.

Parts of a Websheet URL

The following is an example of a Websheet URL:


ws?p=
Indicates that you are accessing an Oracle Application Express Websheet application.

4350
The application ID. Specifies which Websheet application.

1
The page ID. Specifies which page within the application. Depending on how the developer configured the page, the page ID may be a word, such as home.

220883407765693447
The session ID. The Application Express engine uses the session ID to fetch session state from the database. Oracle Application Express assigns new session IDs during authentication processing, records the authenticated user's identity with the session ID, and continually checks the session ID in each page request's URL or POST data with the session cookie and the session record in the database.

WARNING:

Do not enter the session state ID when you access a Websheet URL. Entering information beyond the page ID displays an error.

See Also:

"About Session IDs" in the Oracle Application Express App Builder User's Guide

5.2.2 Accessing a Websheet

To access a Websheet, the Websheet developer provides you a URL and login credentials (that is, a username and password). Ensure the URL includes the application ID and page ID, but not the session state ID.

To access a Websheet:

1. Click the supplied URL, or enter it in your browser's Address field.
2. Enter your Websheet credentials:
a. Username - Enter your username.

b. Password - Enter your password.

c. Click **Sign In**.

The browser navigates to the Websheet.

If you do not have a URL or the URL does not work, contact the person who created the Websheet.

---

**See Also:**

"Understanding Session State Management" in *Oracle Application Express App Builder User's Guide*

---

### 5.3 Using Websheets

The Websheet application interface contains various elements for quick navigation and robust text editing.

- **Breadcrumb Sections**
  A breadcrumb displays at the top of every Websheet page. Click the down arrow next to the home breadcrumb to display a submenu of links to all Websheet pages.

- **Navigation Sections**
  Websheets can contain multiple pages. Each navigation section includes a hierarchical tree that enables you to navigate between pages or page sections.

- **Showing and Hiding Page Sections**
  To hide and show a section, click the arrow to the left of a section name.

- **Online Help**
  A Help button displays in the upper right corner of each page. Clicking Help displays a small Help system that provides an overview of Websheet functionality.

- **Signing out of a Websheet**
  Click the Sign out button to exit a Websheet.

- **About the Websheet Search Bar**
  Perform case insensitive searches of application content in the Search Websheet search bar.

- **Control Panel**
  For users with developer and administrator rights, the Control Panel displays on the right side of most Websheet pages.

### 5.3.1 Breadcrumb Sections

A breadcrumb displays at the top of every Websheet page. Click the down arrow next to the home breadcrumb to display a submenu of links to all Websheet pages.

To view another page, click the child breadcrumb entry.
5.3.2 Navigation Sections

Websheets can contain multiple pages. Each navigation section includes a hierarchical tree that enables you to navigate between pages or page sections.

Click the arrows on the left to expand or collapse the tree. To open a specific section or page, click it. Click **Expand All** to view all pages and page subsections. Click **Reset** to return the tree to the default display.

**See Also:**

*Adding a Navigation Section*
5.3.3 Showing and Hiding Page Sections

To hide and show a section, click the arrow to the left of a section name.

5.3.4 Online Help

A Help button displays in the upper right corner of each page. Clicking Help displays a small Help system that provides an overview of Websheet functionality.

Available tabs include: About, Overview, Access Control, Markup Syntax, Data Grid, Application Content, and FAQ.

See Also:

"About Websheet Applications" in Oracle Application Express App Builder User's Guide

5.3.5 Signing out of a Websheet

Click the Sign out button to exit a Websheet.
• To exit a running Websheet, click **Sign out** in the upper right corner.

### 5.3.6 About the Websheet Search Bar

Perform case insensitive searches of application content in the Search Websheet search bar.

The Search Websheet field displays in the upper right of each Websheet page.

To search a Websheet, click **Search Websheet**, enter your query, and press **Enter**. Search results display in a report. To refresh the view, click the **Search** button.

Once the search results display, use the Search region on the right side of the page to control what content to search. Searchable Content options include:

- Page Name
- Page Alias
- Page Description
- Section title
- Section content
- File Name, Alias, Description
- Tags
- Notes
- Data Grid Data
5.3.7 Control Panel

For users with developer and administrator rights, the Control Panel displays on the right side of most Websheet pages.

You can click the arrow to the right of the region title to hide or display the Control Panel.

The Websheet Control Panel contains the following options:

- New Sections. See "Adding and Editing Page Sections."
- Edit Sections. See "Adding and Editing Page Sections."
- New Page. See "Adding a New Page."
- New Page as a Copy. See "Copying an Existing Page."
- Edit Page. See "Editing Page Details."
- Page Directory. See "Viewing the Page Directory."
- New Data Grid. See "Creating a Data Grid."

5.4 Managing Websheet Pages

You can add pages to a Websheet manually or copy existing pages.

Tip:

You can also add a new page by clicking New Page and New Page as a Copy on the Control Panel.

- Adding a New Page
  Add a new page to a Websheet by clicking New Page in the Create menu.
• **Copying an Existing Page**
  Copy a page in a Websheet by clicking New Page as a Copy in the Create Menu.

• **Editing Page Details**
  Edit the details of a Websheet page (such as the name, parent page, and description) by clicking Edit Page in the Edit menu.

### 5.4.1 Adding a New Page

Add a new page to a Websheet by clicking New Page in the Create menu.

To add a new Websheet page:

1. Run the Websheet application.
2. From the Create menu, select **New Page**.
3. On Create Page:
   a. **Name** - Enter a page name. The page name displays as the window title and in the breadcrumb.
   b. **Page Alias** - Identify the page alias. This alias enables you to link to this page.
   c. **Parent Page** - If this page is part of a page hierarchy, then select the parent page.
   d. Click **Create Page**.

### 5.4.2 Copying an Existing Page

Copy a page in a Websheet by clicking New Page as a Copy in the Create Menu.

To copy an existing page:

1. Run the Websheet application.
2. From the Create menu, select **New Page as a Copy**.
3. In New Page Name, enter the name of the new page.
4. Click **Copy Page**.
   A success message appears.
5. Select one of the following:
   - **View Current Page**
   - **View New Page**
5.4.3 Editing Page Details

Edit the details of a Websheet page (such as the name, parent page, and description) by clicking Edit Page in the Edit menu.

On Page Details, you can change the page name, alias, parent page, or page description.

To edit page details:
1. Run the Websheet application.
2. From the Edit menu, select Edit Page.
3. On the Details Page:
   • Name - Identifies the name of the page. The page name displays in the window title and in the breadcrumb.
   • Alias - A page alias enables you to create links in page sections to other pages. A page alias must be unique within an application.
   • Owner - Identifies the owner of the page.
   • Parent Page - Identifies the parent page. The defined parent page is used to construct breadcrumbs and navigation between pages.
   • Page Description - Descriptive text that describes the page.
4. Click Apply Changes.
   A success message appears.

Tip:
You can also edit page details by clicking Edit Page on the Control Panel.

5.5 Adding and Editing Page Sections

You can add new sections to a Websheet page with the Create menu and edit existing sections with the Edit button and Edit menu.
5.5.1 About Page Section Types

Websheets are organized into pages which consist of containers called sections.

To each Websheet page, you can add the following section types:

Text
Display entered text, inline images, inline reports, links to reports, data grids, other pages, files, external URLs, and so on. You can create and modify text sections using an intuitive WYSIWIG editor. See "Adding and Editing Text Sections."

Navigation
Add dynamically generated navigation to subordinate pages or page sections. See "Adding a Navigation Section."

Data
Create inline reports based upon a data grid or report. See "Creating Data Sections Based on a Data Grid or Report" and "Adding Data Reports."

Chart
Create inline charts based upon a data grid or report. See "Creating Chart Sections."

5.5.2 Editing Page Sections

Edit a section of a Websheet by clicking its Edit button.

To edit a page section:

1. Run the Websheet.
2. Click the Edit icon that displays in the upper right of each section.
The Edit Section page appears.

Tip:
The left side of the Edit Section page lists all sections on the current page. The current section is highlighted. To access another section, select it.

3. Edit the section and click Apply Changes.

5.5.3 Deleting Page Sections

Delete a section of a Websheet by opening its Edit Section page.

To delete a page section:
1. Run the Websheet.
2. Click the Edit icon that displays in the upper right of the section.
   The Edit Section page appears.
3. Click Delete.

5.5.4 Editing Section Titles and Display Order

Change the title and display order of a section on the Edit Sections page.

To edit all sections:
1. Run the Websheet application.
2. From the Edit menu, select Edit Sections.
The Edit Sections page appears.

3. To edit the section title, enter a new title.
4. To change the section order, click the **Up** and **Down** arrows adjacent to the section title.
5. Click **Apply Changes**.

---

**Tip:**
You can also edit sections by clicking **Edit Sections** on the Control Panel.

### 5.6 Adding and Editing Text Sections

You can create a Text section to add text to a Websheet page. You can type directly into a text section, or copy and paste content from a spreadsheet.

Copying and pasting from a spreadsheet creates a new section for each spreadsheet row.

- **Adding a Text Section**
  Add a Text section to a Websheet by clicking New Section in the Create menu.

- **Editing a Text Section**
  Edit and format a text section in a Websheet by clicking its Edit icon.

---

**See Also:**

- Deleting Page Sections
- Understanding Markup Syntax
5.6.1 Adding a Text Section

Add a Text section to a Websheet by clicking New Section in the Create menu.

To add a text section:

1. Run the Websheet application.
2. From the Create menu, select **New Section**.
3. When prompted for the section type, select **Text** and click **Next**.
4. On Create Text Sections select either:
   - **Create single text section**
   - **Create multiple text section from Spreadsheet**
5. If you select **Create single text section**, specify the following:
   a. Sequence - Enter the section display sequence.
   b. Title - Enter a section title.
   c. Content - Enter text. To learn more about formatting text, see "Editing a Text Section."
   d. Click **Create Section**.
6. If you select **Create multiple text section from Spreadsheet**, specify the following:
   a. First Row Contains Column Headings - Select this option if applicable.
   b. Paste Spreadsheet Data - Paste a two column spreadsheet or other tab delimited data. The first column must contain the section title and the second column must contain the section content.
   c. Click **Create Section**.

**Tip:**
You can also add a new section by selecting **New Section** on the Control Panel.

5.6.2 Editing a Text Section

Edit and format a text section in a Websheet by clicking its Edit icon.

To edit a text section:

1. Run the Websheet application.
2. Click the **Edit** icon that displays in the upper right of the section.
The Edit Section page appears.

3. Edit the text in the field provided.

4. To change the formatting, click the **Expand Toolbar** icon in the upper right corner.

The Toolbar appears. When you pass your cursor over an icon, a descriptive tooltip displays.

5. To hide the toolbar, click the **Collapse Toolbar** icon.
Add dynamically generated navigation to subordinate pages or page sections by clicking New Section in the Create menu and create a Navigation section.

To add a navigation section:

1. Run the Websheet application.
2. From the Create menu, select New Section.
3. When prompted for the section type, select Navigation and click Next.
4. For Navigation Type:
   a. Select either:
      i. Page Navigation - Creates navigation of all pages in the Websheet.
      ii. Section Navigation - Creates navigation for all sections on a page.
   b. Click Next.
5. If you select Page Navigation, specify the following:
   a. Sequence - Enter the section display sequence.

To save your changes, click Apply Changes.

See Also:
Understanding Markup Syntax
5.8 Managing Data Grids

Data grids are sets of data displayed in rows and columns. Data grids store data in a similar way to how spreadsheets store data. Once created, the structure can be modified as needed over time.

- **About Data Grids**
  You can define the structure of a data grid using column names, data sources, and basic validations, or you can create a data grid by pasting spreadsheet data. Once created, the structure can be modified as needed.

- **Creating a Data Grid**
  You can create a data grid by either defining the structure (that is, the column names, data sources, and basic validations), or by pasting in spreadsheet data.

- **Copying a Data Grid**
  Copy a data grid by clicking Copy in the Manage menu.

- **Viewing and Editing a Data Grid**
  Once you create a data grid, you can view and edit it on the Data page.

- **Viewing the Data Grid Change History Log**
  View the change history log of a data grid by selecting History in the Manage menu.

- **Deleting a Data Grid**
  Delete a data grid by selecting Delete Data Grid in its Manage menu.
5.8.1 About Data Grids

You can define the structure of a data grid using column names, data sources, and basic validations, or you can create a data grid by pasting spreadsheet data. Once created, the structure can be modified as needed.

You can alter the layout of report data by selecting columns or by applying filters, highlighting, and sorting. You can also define breaks, aggregations, group bys, computations, and different charts.

Additionally, you can create multiple variations of a data grid and save them as named reports, for either public or private viewing. You can also use the data from a data grid and include it as a chart or report within any page.

5.8.2 Creating a Data Grid

You can create a data grid by either defining the structure (that is, the column names, data sources, and basic validations), or by pasting in spreadsheet data.

In addition to the defined columns, the following standard columns are always included within each data grid: owner, created by, created on, updated by, updated on, row order, and annotation (files, notes, links, and tags).

- **Creating a Data Grid from Scratch**
  Create a data grid from scratch by clicking New Data Grid in the Create menu and selecting From Scratch.

- **Creating a Data Grid by Copying and Pasting Spreadsheet Data**
  Create a data grid by copying and pasting spreadsheet data by clicking New Data Grid in the Create menu and selecting Copy and Paste.

5.8.2.1 Creating a Data Grid from Scratch

Create a data grid from scratch by clicking New Data Grid in the Create menu and selecting From Scratch.

When you create a data grid from scratch you must define the column names, datatypes, and basic values. Once you have created the basic structure, you can then populate it with data.

To create a data grid from scratch:
1. Run the Websheet application.
2. From the Create menu, select New Data Grid.

Tip:
You can also select New Data Grid on the Control Panel.

3. When prompted for the section type, select From Scratch and click Next.
4. Specify the following:
   a. Name - Enter a data grid name.
   b. Alias - Enter a data grid alias. Use this alias to link to this data grid within other page sections. A data grid alias must be unique within an application.
   c. Define the data grid structure by specifying the column name and data type. To change the order, click the Up and Down arrow under Move.
   d. Click Create Data Grid.
      The data grid appears.
5. To add data, click Add Row.

See Also:
Editing Data Grid Data

5.8.2.2 Creating a Data Grid by Copying and Pasting Spreadsheet Data

Create a data grid by copying and pasting spreadsheet data by clicking New Data Grid in the Create menu and selecting Copy and Paste.

To create a data grid by copying and pasting spreadsheet data:
1. Run the Websheet application.
2. From the Create menu, select New Data Grid.

Tip:
You can also select New Data Grid from the Create menu or the Control Panel.

3. When prompted for the section type, select Copy and Paste and click Next.
4. Specify the following:
a. Name - Enter a data grid name.

b. Alias - Enter a data grid alias. You can use this alias to link to this data grid within page sections. A data grid alias must be unique within an application.

c. First Row Contains Column Headings - Select this option if applicable.

d. Paste Spreadsheet Data - Copy and paste the data you want to load from a spreadsheet program.

e. Click Upload.

A data grid appears.

5.8.3 Copying a Data Grid

Copy a data grid by clicking Copy in the Manage menu.

To copy a data grid:

1. Run the Websheet application.

2. From the Data Grid menu, select an existing data grid.

   The data grid appears.

3. From the Manage menu, select Copy.

4. Enter a new data grid name and click Copy.

5.8.4 Viewing and Editing a Data Grid

Once you create a data grid, you can view and edit it on the Data page.

Tip:

Data grids display as an interactive report.

- Accessing the Data Page
  Access the Data page by selecting View All in the Data Grid menu.

- Toggling Check Boxes
  Toggle whether check boxes display when viewing a data grid by selecting Toggle Checkboxes in the Manage menu.

- Editing Data Grid Data
  Edit the data in a data grid by clicking a valid cell or add a new row by clicking the Add Row button.

- Editing Data Grid Columns Manually
  Manually edit columns in a data grid by clicking Columns in the Manage menu.

- Editing Data Grid Rows Manually
  Manually edit rows in a data grid by clicking Rows in the Manage menu.

- Editing a Single Data Grid Row
  Edit a single row in a data grid by clicking its Edit Row icon (pencil).

- Adding Annotations to a Single Data Grid Row
  Add annotations to a row in a data grid by clicking its Edit Row icon (pencil).
• **Displaying Annotation Columns in a Data Grid Report**  
Choose which columns to display in a data grid by clicking the Actions menu and selecting Select Columns.

• **Displaying Pseudo Columns in a Data Grid Report**  
Choose whether to display pseudo columns in a data grid report by clicking the Actions menu and selecting Select Columns, then save the report.

• **Editing Data Grid Properties**  
Change the name, alias, and description of a data grid on the Data Grid Properties page.

• **Creating a Bookmark Link to a Data Grid**  
Create a bookmark link to a data grid by adding the appropriate syntax to the URL of its parent Websheet or retrieving the URL manually.

---

**See Also:**

• Using Interactive Reports
• Customizing an Interactive Report Using the Actions Menu

---

### 5.8.4.1 Accessing the Data Page

Access the Data page by selecting View All in the Data Grid menu.

To access the Data page:

1. Run the Websheet application.
2. From the Data Grid menu, select **View All**.

An interactive report appears displaying all data grids. The report also appears in the Report view.

---

**Tip:**

If icons display, then click the **View Report** icon.
By default, the Report view displays the data grid Name, Alias, Updated, and Updated By columns. The Embed Tag column displays the syntax used to include a link to the report or data grid from within a section of a page.

3. Select a data grid.

The data grid appears.

5.8.4.2 Toggling Check Boxes

Toggle whether check boxes display when viewing a data grid by selecting Toggle Checkboxes in the Manage menu.

Use the checkboxes for custom selections.

- To display checkboxes adjacent to each row:
  - Click the Manage menu and select Toggle Checkboxes.

When enabled, check boxes display to the left of each row.
5.8.4.3 Editing Data Grid Data

Edit the data in a data grid by clicking a valid cell or add a new row by clicking the Add Row button.

To edit data grid data:
1. Run the Websheet application.
2. From the Data Grid menu, select a data grid.
   The data grid appears.
3. Click a valid cell.
   The cell expands into an editable text field.
4. When finished, click outside of the cell or press the Tab key to proceed to the next cell in the column.
   Changes are saved automatically.

To add another row:
5. Click the Add Row button.
   A form appears.
6. Edit the fields provided. Each field is a column within the new row.
7. Click either Save or Save and Add Another.

Tip:
You can also edit an entire row by clicking the Edit Row button (pencil) adjacent to the row.

5.8.4.4 Editing Data Grid Columns Manually

Manually edit columns in a data grid by clicking Columns in the Manage menu.

To manually edit data grid columns:
1. Run the Websheet application.
2. From the Data Grid menu, select a data grid.
   The data grid appears.
3. From the Manage menu, select Columns.
   The following submenu displays:

   Add
   Adds a new column. Enables you to define all column properties such as the column name, group, type, value required, display as, list of values, default type, and so on.

   Column Properties
   Editable properties include sequence, group, required value, display as, label, format, heading alignment, column alignment, default text, help text, and so on.
List of Values
Enables you to restrict the values a user can enter. You associate a list of values with a column on Column Properties.

Column Groups
Create a group and add columns to the group. Enables you to define the group name and provide a description. You can select the columns for the new column group in the Column region by using the arrow keys.

Validation
Enables you to define a column validation, sequence, validation expression, and error message.

Delete Columns
Select columns to delete.

4. Select a submenu option and follow the on-screen instructions.

5.8.4.5 Editing Data Grid Rows Manually

Manually edit rows in a data grid by clicking Rows in the Manage menu.

To manually edit data grid rows:

1. Run the Websheet application.
2. From the Data Grid menu, select a data grid.
   The data grid appears.
3. From the Manage Menu, select Rows.
   The following submenu displays:

   Add Row
   Adds a new row. Enables you to define the project, task, start date, end date, and so on.

   **Tip:**
   You can also click the Add Row button in the data grid to add a new row.

   Set Column Values
   Set a predefined value for a column for all rows, selected rows, or empty rows.

   Replace
   Search and replace row values for all rows or selected rows.

   Fill
   Fill NULL column values with a column value from the above cell. Select a column from which you want to fill the NULL column value.

   Delete Rows
   Select to delete all rows, selected rows, or rows with empty columns.

4. Select a submenu option and follow the on-screen instructions.
5.8.4.6 Editing a Single Data Grid Row

Edit a single row in a data grid by clicking its Edit Row icon (pencil).

To manually edit a single data grid row:

1. Run the Websheet application.
2. From the Data Grid menu, select a data grid.
   The data grid appears.
3. Locate the row to be edited and click the **Edit Row** icon.
   The Add/Edit Row page appears.
4. Edit the appropriate rows and click **Apply Changes**.

**Tip:**
You can use the Actions region on the Add/Edit Row page to add a new row, add a file, add annotations, add links, add tags, view a history of changes, add a column, edit column properties and group, delete columns, and create a list of values or a validation.

5.8.4.7 Adding Annotations to a Single Data Grid Row

Add annotations to a row in a data grid by clicking its Edit Row icon (pencil).

To add annotations (that is, files, notes, links, and tags) to a single data grid row:

1. Run the Websheet application.
2. From the Data Grid menu, select a data grid.
   The data grid appears.
3. Locate the row to be edited and click the **Edit Row** icon.
   The Add/Edit Row page appears.
4. From the Actions region, select one of the following:
   • Add File
   • Add Note
   • Add Link
   • Add Tags

5. Follow the on-screen instructions.

See Also:
Managing Annotations

5.8.4.8 Displaying Annotation Columns in a Data Grid Report

Choose which columns to display in a data grid by clicking the Actions menu and selecting Select Columns.

To display annotation columns (such as Files, Notes, Links, and Tags) in a data grid report:

1. View the data grid report.
2. Click the Actions menu and then Select Columns.
3. In the Select Columns region, move the columns (for example, Files, Notes, Links, and Tags) to Display in Report.
4. Click Apply.

To ensure that all users can see the columns, developers can save the revised layout as the default report.

To save a new default report:
5. Click the Actions menu and select Save Report.
   The Save Report Region appears.
6. In Save Report:
   a. Save - Select As Default Report Settings.
   b. Name - Enter a name for the report.
   c. Description - Enter an optional description.
   d. Click Apply.

5.8.4.9 Displaying Pseudo Columns in a Data Grid Report

Choose whether to display pseudo columns in a data grid report by clicking the Actions menu and selecting Select Columns, then save the report.

Data grids include the following pseudo columns:

Owner
The username who created the row.
Row Key
The user-friendly alphanumeric unique key to identify a row.

Row Order
The unique number to identify a row.

Created By
The username who created the row.

Created On
The date when the row was created.

To display pseudo columns in a data grid report:
1. Include the pseudo columns in the data grid report:
   a. View the data grid report.
   b. Click the Actions menu and then Select Columns.
   c. In the Select Columns region, move the pseudo columns to Display in Report.
   d. Click Apply.
2. Save a new default report:
   a. Click the Actions menu and select Save Report.
      The Save Report Region appears.
   b. In Save Report:
      i. Save - Select As Default Report Settings.
      ii. Name - Enter a name for the report.
      iii. Description - Enter an optional description.
      iv. Click Apply.

5.8.4.10 Editing Data Grid Properties

Change the name, alias, and description of a data grid on the Data Grid Properties page.

To edit data grid properties:
1. Run the Websheet application.
2. From the Data Grid menu, select a data grid.
   The data grid appears.
3. From the Manage menu, click Properties.
   The Data Grid Properties page appears.
4. Edit the fields provided and click Apply.

5.8.4.11 Creating a Bookmark Link to a Data Grid

Create a bookmark link to a data grid by adding the appropriate syntax to the URL of its parent Websheet or retrieving the URL manually.

To bookmark directly to a data grid or a row:
1. Use the following syntax:

   ws?p=100000:DG_<data grid alias>
   ws?p=100000:DG_<data grid alias>::ROW_ID:<data grid row ID>

   The data grid row ID is an ID column value of the APEX$_WS_ROWS table.

To get a link to a specific data grid row:

2. Run the data grid.
3. Click the Edit Row icon.
4. Note the URL in the browser.

5.8.5 Viewing the Data Grid Change History Log

View the change history log of a data grid by selecting History in the Manage menu.

The View Change History log displays a report of data grid changes. This report lists
the row, column name, old value, new value, user who authored the change, and how
long ago the change occurred.

To view a history of data grid changes:

1. Run the Websheet application.
2. From the Data Grid menu, select a data grid.
   The data grid appears.
3. From the Manage menu, select History.

5.8.6 Deleting a Data Grid

Delete a data grid by selecting Delete Data Grid in its Manage menu.

To delete a data grid:

1. Run the Websheet application.
2. From the Data Grid menu, select a data grid.
   The data grid appears.
3. From the Manage menu, select Delete Data Grid.
4. Confirm your selection and click Delete.

5.9 Adding and Editing Data Content

Add content to Websheets that is queried from your Oracle Database (such as data
grids and reports). Note: this function requires your application’s developer to enable
the Allow SQL attribute.

- **About Available Data Sources**
  You can include other Oracle Application Express data sources in Websheets. Once defined, you can incorporate these data sources into Websheet page sections.

- **Enabling Support for Creating Data Reports**
  To define a data report, your Websheet developer must enable the Allow SQL attribute on the Application Properties page.
5.9.1 About Available Data Sources

You can include other Oracle Application Express data sources in Websheets. Once defined, you can incorporate these data sources into Websheet page sections.

Websheets can include the following data sources:

**Data Grids**
Data grids are highly customizable, editable tabular reports. Data grids enable you to maintain data within the Websheet that is stored within the Oracle Database. See "Managing Data Grids."

**Reports**
Reports are queries defined against tables or views that exist within your Oracle Database. See "Adding Data Reports."

5.9.2 Enabling Support for Creating Data Reports

To define a data report, your Websheet developer must enable the Allow SQL attribute on the Application Properties page.

By default, this attribute is disabled.

- To enable support for creating data reports:
- Contact your developer.

Only a Websheet application developer can edit the Allow SQL attribute on the Application Properties page.

See Also:

5.9.3 About Incorporating Data into Websheet Pages

Data grids and data reports can be incorporated into page sections in the following ways.

**Within a Data Section**
See "Adding Data Reports."

**Within a Chart Section**
See "Adding a Chart Section."

**Linking to a Data Grid**
See "Linking to a Data Grid."
Include a single value or tabular results of queries
See "Using SQL and SQLVALUE Syntax."

5.10 Adding Data Reports

Data reports are contributor defined queries on tables or views within the underlying Oracle Database.

**Important:**

Before you can add a data report, your Websheet application developer must enable the **Allow SQL** attribute on the Websheet properties page. By default, this attribute is disabled.

- **About Data Reports**
  Data reports, unlike data grids, are query-only and based on existing data from the Oracle Database. You can specify the table or view name and retrieve all columns or write a SQL statement to retrieve the required data.

- **Creating a Data Report**
  Create a data report either by entering the table or view name or by providing a SQL query.

- **Viewing and Modifying a Data Report**
  View a data report by selecting View All in the Report menu, then edit the report by clicking Edit Attributes.

- **Deleting a Data Report**
  Delete a data report from a Websheet by clicking Delete in the Report Attributes page.

**See Also:**

- Adding and Editing Data Content
- Understanding Markup Syntax
- "Editing Websheet Application Properties" in Oracle Application Express App Builder User’s Guide

5.10.1 About Data Reports

Data reports, unlike data grids, are query-only and based on existing data from the Oracle Database. You can specify the table or view name and retrieve all columns or write a SQL statement to retrieve the required data.

You can alter the layout of report data by selecting columns or by applying filters, highlighting, and sorting. You can also define breaks, aggregations, group by, computations, and different charts.
Additionally, you can create multiple variations of a data grid and save them as named reports, for either public or private viewing. You can also use the data from a data report and include it as a chart or report within any page.

See Also:

- Creating Data Sections Based on a Data Grid or Report
- Creating Chart Sections

5.10.2 Creating a Data Report

Create a data report either by entering the table or view name or by providing a SQL query.

To create a data report:

1. Run the Websheet application.

Tip:

You can also select New Report on the Control Panel.

The Create Report page appears.

3. For Report Source, identify how to develop your source. Options include:
   - **Table** - Select Table and enter the following:
     - Table or View Name - Select the name of the table or view on which to base the report.
     - Report Name - Enter the name of the report.
     - Report Alias - Enter a report alias. A Report alias is used for linking to the Report within page sections. A Report alias must be unique within an application.
   - **SQL Query** - Select SQL Query and enter the following:
     - Report Name - Enter the name of the report.
     - Query - Enter the SQL query that defines your report.

4. Click Next.
5. Confirm your selections and click Create Report.
5.10.3 Viewing and Modifying a Data Report

View a data report by selecting View All in the Report menu, then edit the report by clicking Edit Attributes.

To view or modify a data report:
1. Run the Websheet application.
2. From the Report menu, select **View All**.
   The Report page appears.
3. Select the report.
   The report appears.
4. To edit report attributes:
   a. From the Manage menu, click **Edit Attributes**.
      The Report Attributes page appears.
   b. Edit the attributes and click **Apply Changes**.
5. To edit the report query:
   a. From the Manage menu, click **Edit Query**.
      The Report Query page appears.
   b. Edit the report query and click **Apply Changes** to save your query.

5.10.4 Deleting a Data Report

Delete a data report from a Websheet by clicking Delete in the Report Attributes page.

To delete a data report:
1. Run the Websheet application.
2. From the Report menu, select the report.
   The report appears.
3. Select the report.
   The report appears.
4. From the Manage menu, click **Edit Attributes**.
   The Report Attributes page appears.
5. Click **Delete**.

5.11 Creating Data Sections Based on a Data Grid or Report

Add a data grid or data report to a Websheet with data sections.

- **Adding a Data Section to a Page**
  Add a data section to a page by selecting Data in the New Section wizard, then specify how to import the desired data grid or report.
• **Editing a Data Section**
  Edit a data section by clicking its adjacent Edit icon.

---

**See Also:**
Adding and Editing Data Content

---

### 5.11.1 Adding a Data Section to a Page

Add a data section to a page by selecting Data in the New Section wizard, then specify how to import the desired data grid or report.

If you do not have a saved report with the settings you need, create it now before adding the section.

Once you create a data grid or report, you add it to a page by adding a data section.

To add a data section:

1. Run the Websheet application.
2. From the Create menu, select **New Section**.
3. When prompted for the section type, select **Data** and click **Next**.
4. Specify the following:
   a. Data Section Source - Select either **Data Grid** or **Report**.
   b. Display Sequence - Enter the section display sequence.
   c. Data Grid/Report - Select the data grid or report to be used to display the data section.
   d. Report Settings to Use - For the selected data grid or report, select the report settings to use. This selection enables you to filter the rows and columns you want to display and set the columns to display.
   e. Title - Enter the section title.
   f. Maximum Row Count - Enter a value to define the maximum number of rows to query.
   g. Include - Select whether to add the following:
      • Add Row (available if Data Section Source is data grid)
      • Edit Row (available if Data Section Source is data grid)
      • Search Field
   h. Style - Choose a user interface style.
5. Click **Next**.
6. Click **Create Section**.
5.11.2 Editing a Data Section

Edit a data section by clicking its adjacent Edit icon.

Once you have added a data report to a page, you can change the section sequence, title, and user interface style.

To edit a data section:
1. Run the Websheet application.
2. Click the Edit icon that displays in the upper right of the section.
   The Edit Section page appears.
3. Edit the fields provided. See item Help for more details.
4. To save your changes, click Apply Changes.

5.12 Creating Chart Sections

You can create inline charts based upon a data grid or report.

- Adding a Chart Section
  Add a chart section to a Websheet by clicking New Section in the Create menu and selecting Chart.

- Editing a Chart Section
  Edit a chart section in a Websheet by clicking its adjacent Edit icon.

5.12.1 Adding a Chart Section

Add a chart section to a Websheet by clicking New Section in the Create menu and selecting Chart.

To add a chart section:
1. Run the Websheet application.
2. Create a data grid or report.
3. From the Create menu, select New Section.
4. When prompted for the section type, select Chart and click Next.
5. On Select Chart Type:
   a. Select one of the following:
      • Column
      • Horizontal Bar
      • Pie
      • Line
   b. Click Next.

6. Specify the following:
   a. Chart Source - Select either Data Grid or Report.
   b. Display Sequence - Enter the section display sequence.
   c. Data Grid/Report - Select the data grid or report to be used to display the chart.
   d. Report Settings to Use - For the selected data grid or report, select the report settings to use. Use this option to filter the rows and columns you want to display.
      If you do not have a saved report with the settings you need, then create it now before adding the section.
   e. Section Title - Enter the section title.
   f. Click Next.

7. Specify the following:
   a. Chart Label - Select the column to be used as the Label.
      In Axis Title for Label, enter the title to display on the axis associated with the column selected for Label.
   b. Chart Value - Select the column to be used as the Value. If your function is a COUNT, a Value does not need to be selected.
      In Axis Title for Value, enter the title to display on the axis associated with the column selected for Value.
   c. Function - Select a function to be performed on the column selected for Value.
   d. Sort - Select the chart sort direction.
      Check Enable 3D to display the chart in 3D.
   e. Click Next.

8. On the summary page, confirm your selections and click Create Section.

---

See Also:

- Managing Data Grids
- Adding Data Reports
5.12.2 Editing a Chart Section

Edit a chart section in a Websheet by clicking its adjacent Edit icon.

To edit a chart section:

1. Run the Websheet application.
2. Click the **Edit** icon that displays in the upper right of the section.
   The Edit Section page appears.
3. Edit the fields provided. See item Help for more details.
4. Click **Apply Changes**.

5.13 Understanding Markup Syntax

You can use the following syntax for adding links to Websheet pages, page sections, external URLs, data grids, or for including SQL or SQLVALUE syntax.

- **Tip:**
  A Help button displays in the upper right corner of each Websheet page. The Help page, Markup Syntax, lists all the different syntax options described in this section.

- **Linking to a Page**
  You can include links in page sections to other pages in a Websheet by using the following syntax.

- **Linking to a Section**
  You can include links to a page section by using the following syntax.

- **Linking to External URLs**
  You can include links to external URLs in page sections by using the following syntax.

- **Linking to a Data Grid**
  You can include links to data grids within page sections by using the following syntax.

- **Using SQL and SQLVALUE Syntax**
  You can include single value and tabular results of queries against data grids or tables and views within sections of a page by using SQL or SQLVALUE syntax.

- **Advanced Data Grid Queries Rules**

**See Also:**
Managing Uploaded Files and Images
5.13.1 Linking to a Page

You can include links in page sections to other pages in a Websheet by using the following syntax.

If the page exists, a link displays. If the page does not exist, a link to create the page displays. Note that the use of the page: identifier is optional.

Syntax:

`[[ page: <page alias> | <link name> ]]`
`[[ <page alias> | <link name> ]]`

Syntax Example:

`[[page: home]]`
`[[mypage | My Page]]`

In Context Example:

One of the most colorful fish is the `[[ clownfish | Clown fish]]`.

5.13.2 Linking to a Section

You can include links to a page section by using the following syntax.

If the section exists, a link displays. If the section does not exist, a link to create the section displays. Note that if the section is not prefaced by a page, it is assumed the section is on the current page.

Syntax:

`[[ section: <page alias> . <page section> | <link name> ]]`
`[[ section: <page section> | <link name> ]]`

Syntax Example Linking Within the Current Page:

`[[section: clownfish | Clown Fish]]`

Syntax Example Linking to a Different Page:

`[[section: fish.clownfish | Clown Fish]]`

In Context Example:

One of the most colorful fish is the `[[ section: clownfish | Clown fish]]`. Visit or fish page to see the `[[ section: fish . clownfish | Clown fish]]`, also known as Nemo.

5.13.3 Linking to External URLs

You can include links to external URLs in page sections by using the following syntax.

Note that the use of the url: identifier is optional. To have the link open in a new browser window, use the popup prefix.
Syntax:

[[ url: <url> | <link name> ]]
[[ popupurl: <url> | <link name> ]]
[[ <url> | <link name> ]]

Syntax Example:

[[url: http://www.company.com/store | companystore]]
[[popupurl: http://www.company.com/store | companystore]]
[[http://www.searchengine.com | searchengine]]
[[http://www.searchengine.com ]]

In Context Example:

You can buy Company software on the [[http://www.company.com/store | Company Store]] website.

5.13.4 Linking to a Data Grid

You can include links to data grids within page sections by using the following syntax.

You can use these links to view the data grid or to create new data.

Tip:

Note that data grid can be one or two words.

Syntax:

[[ data grid: <datagrid alias | <link name> ]]  
[[ datagrid: <datagrid alias | <link name> ]]  
[[ datagrid: <datagrid alias . <saved report name (may not be private) | <link name> ]]  

Syntax Example:

[[ data grid: todo list | To Do List ]]  
[[ data grid: todo list . open todo items | To Do List ]]  
[[ datagrid: todo list | To Do List ]]  

In Context Example:

Please review the [[ data grid: todo list | To Do List ]] and ensure your tasks can be accomplished by Friday.

5.13.5 Using SQL and SQLVALUE Syntax

You can include single value and tabular results of queries against data grids or tables and views within sections of a page by using SQL or SQLVALUE syntax.

The SQLVALUE tag displays the first column of the first row returned by the SQL query. Use this syntax to embed data within a sentence (for example: There are currently 5 types of cats.). For tabular results, use the SQL tag. Using SQL tag produces a
searchable report. However, you can disable the search option by using the \texttt{NOSEARCH} syntax.

When working with data grids, there are a few more options (shown under Syntax) and a few more rules. Basic rules when writing a data grid query include:

- Enclose the data grid name or data grid alias with braces. For example:
  
  \{Cat Facts\}

- Enclose the data grid column names with double quotation marks. For example:

  "Type of Cat"

\textbf{See Also:}

Advanced Data Grid Queries Rules

**Syntax for Queries Against Tables and Views:**

\[
[[\text{sql: <select statement> }]]
\]

\[
[[\text{sql: <select statement | limit="<maximum rows>" nosearch style="<style number>" }}]]
\]

\[
[[\text{sqlvalue: <select statement> }]]
\]

**Syntax for Data Grid Queries:**

\[
[[\text{sql: <select statement> }]]
\]

\[
[[\text{sql: <select statement | limit="<maximum rows>" nosearch style="<style number>" edit_row add_row show_sql }}]]
\]

\[
[[\text{sqlvalue: <select statement> }]]
\]

\[
[[\text{sqlvalue: <select statement> | show_sql }}]]
\]

**In Context SQL Tag Syntax Examples:**

\[
[[\text{sql: select ename "Employee Name", sal "Salary" from emp order by sal desc | limit="10" style="2"}]].
\]

\[
[[\text{sql: select "Type of Cat", "Estimated Population", "Largest Threats", "Top Speed", "Scientific Name", "IUCN Status", "Weight", "Study Date" from {Cat Facts} | add_row edit_row }}]]
\]

**In Context SQLVALUE Tag Syntax Examples:**

We have \[[\text{sqlvalue: select count(*) from emp}]] employees in our database, \[[\text{sqlvalue: select count(*) from emp where deptno=10}]\] work in department 10. We are currently tracking \[[\text{sqlvalue: select count(*) from {Cat Facts} }]] types of cats.

**5.13.6 Advanced Data Grid Queries Rules**

Advanced data grid query rules include:
• The query must reference the data grid only once to include an edit or add row link (that is, you cannot join the data grid to itself within the query).

• The first column must be the primary key of the data grid to include an edit row link (that is, the column that uniquely identifies the row of data). If the "edit_row" option is included and the query has a single select statement, the primary key column is included automatically. If the query contains multiple select statements, you can use the "APXWS_DATA_GRID_PK" substitution (always enclosed with double quotation marks) as the first column in the SELECT statement to include the primary key to include an edit row link.

• Report column names are the column name from the data grid, but can be modified using standard SQL column aliasing syntax. For example, the following displays the data from the Minimum Number column but the heading displays as Min:

```sql
select "Minimum Number" "Min" from ...
```

• If a column name is longer than 30 characters, you only include the first 30 characters as the name. For example, use:

"% of Estimated Lions per Regio"

Instead of:

"% of Estimated Lions per Region"

• To display the query that is executed, include the "show_sql" option. By including this option, the query displays above the included report. Although this is a good approach for debugging, Oracle does not recommend "show_sql" for a production application.

5.14 Managing Annotations

Add commentary and additional details to a web sheet in annotations.

Annotations can be in the form of uploaded files, notes, links, and tags. Annotations can be added to both pages and data grid records.

• Managing Uploaded Files and Images
  You can upload files and images to a Websheet page using the Files region. Once uploaded, you can display uploaded images within a page section or embed download links to files.

• Adding Tags
  You can add tags to facilitate keyword searching within a Websheet.

• Adding Notes
  Use notes to record user comments. You can add, edit, and delete notes.

• Viewing and Deleting Annotations
  Annotations include uploaded files, notes, links, and tags that were either added to a Websheet page or to a specific row in a data grid. You can view and delete all Websheet annotations on the Annotations page.
5.14.1 Managing Uploaded Files and Images

You can upload files and images to a Websheet page using the Files region. Once uploaded, you can display uploaded images within a page section or embed download links to files.

- **Uploading Files and Images**
  Upload a file or image to a Websheet by clicking the Add File icon (+) in the Files menu.

- **Including a Download Link in a Page Section**
  You can embed a download link within a page section to uploaded files using the following syntax.

- **Displaying an Uploaded Image Inline**
  After you upload an image, you can display it within any page section of an application by embedding a download link using the following syntax. Reference an uploaded image using the image name or image alias.

- **Editing or Deleting Uploaded Files**
  Edit or delete an uploaded file by clicking the Edit File icon in the Files region.

### 5.14.1.1 Uploading Files and Images

Upload a file or image to a Websheet by clicking the Add File icon (+) in the Files menu.

To upload files and images to a Websheet:

1. Sign in to and run the Websheet.
2. Under Files on the right side of the page, click the **Add File** icon.

3. On the Add File page:
   a. File - Browse to locate the file to upload. Once uploaded, the file is associated with the current page. You can reference an uploaded file in any page using the image or file syntax.
   b. Alias - A file alias enables you to embed download links or image links within page sections. A file alias must be unique within an application.
   c. Description - Enter descriptive text to describe the file.
4. Click **Add File**.

**See Also:**
- Displaying an Uploaded Image Inline

### 5.14.1.2 Including a Download Link in a Page Section

You can embed a download link within a page section to uploaded files using the following syntax.

**Syntax:**

\[
\text{[[ file: < file name > | < link name > ]]} \\
\text{[[ file: < file alias > | < link name > ]]} \\
\]

**Syntax Examples:**

- [[file: myfile ]]
- [[file: myfile.xls ]]
- [[file: myfile | My File ]]

**File Markup Example:**

This [[file: parts01.xls | spreadsheet ]] documents our part numbers.

### 5.14.1.3 Displaying an Uploaded Image Inline

After you upload an image, you can display it within any page section of an application by embedding a download link using the following syntax. Reference an uploaded image using the image name or image alias.

Images defined for the current page are used before images associated with other pages. If image names are ambiguous, the most recently created image displays.

**Syntax:**

\[
\text{[[ image: < file name > | < properties > ]]} \\
\text{[[ image: < file alias > | < properties > ]]} \\
\]

**Syntax Examples:**

- [[image: myimage ]]
- [[image: theimagename.jpg ]]
- [[image: myimage | width="600" alt="my image" ]]

**Example:**

This diagram [[image: diagram1]] illustrates the work flow.

### 5.14.1.4 Editing or Deleting Uploaded Files

Edit or delete an uploaded file by clicking the Edit File icon in the Files region.

To edit details or delete uploaded files:
1. Sign in to and run the Websheet.

2. In the Files region, click the **Edit File** icon.
   The Details page appears.

3. To edit file details:
   a. Edit the fields provided. See item Help for more details.
   b. To accept your changes, click **Apply Changes**.

4. To delete a file:
   a. Click **Delete**.
   b. To accept your changes, click **OK**.

### 5.14.2 Adding Tags

You can add tags to facilitate keyword searching within a Websheet.

- **Adding Tags**
  Add tags to a Websheet page by clicking the Add tag icon (+) in the Tags region.

- **Editing Existing Tags**
  Edit an existing tag by clicking its Edit Tag icon.

- **Deleting Existing Tags**
  Delete a tag by clicking the View Tag icon in the Tags region then selecting it for deletion.

#### 5.14.2.1 Adding Tags

Add tags to a Websheet page by clicking the Add tag icon (+) in the Tags region.

To add tags to a Websheet page:

1. Sign in to and run the Websheet.
2. Under Tags on the right side of the page, click the **Add Tag** icon.

3. Enter tags in the field provided. Separate multiple tags with a comma.
4. Click **Apply Changes**.

#### 5.14.2.2 Editing Existing Tags

Edit an existing tag by clicking its Edit Tag icon.

To edit existing tags:

1. Sign in to and run the Websheet.
2. In the Tags region, click the **Edit Tag** icon.
   The Details page appears.
3. Edit the tags and click **Apply Changes**.

### 5.14.2.3 Deleting Existing Tags

Delete a tag by clicking the View Tag icon in the Tags region then selecting it for deletion.

To delete existing tags:

1. Sign in to and run the Websheet.
2. In the Tags region, click the View Tag icon.
   The Tags page appears.
3. Select the tags that you want to delete and click **Delete Checked**.

### 5.14.3 Adding Notes

Use notes to record user comments. You can add, edit, and delete notes.

- **Adding Notes**
  Add a note to a Websheet page by clicking the Add Note icon (+) in the Notes region.

- **Editing or Deleting Existing Notes**
  Edit or delete a note on a Websheet page by clicking its Edit Note icon.

#### 5.14.3.1 Adding Notes

Add a note to a Websheet page by clicking the Add Note icon (+) in the Notes region.

To add notes to a Websheet page:

1. Sign in to and run the Websheet.
2. Under Notes on the right side of the page, click the Add Note icon.

3. Enter text in the field provided.
4. Click **Add Note**.

#### 5.14.3.2 Editing or Deleting Existing Notes

Edit or delete a note on a Websheet page by clicking its Edit Note icon.

To edit or delete existing notes:

1. Sign in to and run the Websheet.
2. In the Notes region, click the Edit Note icon.
3. To edit file details:
5.14.4 Viewing and Deleting Annotations

Annotations include uploaded files, notes, links, and tags that were either added to a Websheet page or to a specific row in a data grid. You can view and delete all Websheet annotations on the Annotations page.

- **Accessing the Annotations Page**
  Access the Annotations page by selecting Annotations in the View menu.

- **Deleting Annotations**
  Delete annotations from a Websheet by selecting Annotations from the View menu then selecting items for deletion.

5.14.4.1 Accessing the Annotations Page

Access the Annotations page by selecting Annotations in the View menu.

To access the Annotations page:

1. Sign in to and run the Websheet.
2. From the View menu, select **Annotations**.
   - The Annotations page appears.
   - The Annotations page displays as an interactive report.
3. To view specific type of annotation, click the **Files**, **Notes**, **Links**, **Tags**, or **Tag Cloud** tabs.

See Also:

- Using Interactive Reports
- Customizing an Interactive Report Using the Actions Menu

5.14.4.2 Deleting Annotations

Delete annotations from a Websheet by selecting Annotations from the View menu then selecting items for deletion.

To delete uploaded files, notes, link, or tags:

1. Sign in to and run the Websheet.
2. From the View menu, select **Annotations**.
   - The Annotations page appears.
3. Select an annotation type by clicking the appropriate tab at the top of the page.
4. If not selected, click the **View Report** icon.
5. Click the appropriate tab: Files, Notes, Links, Tags, or Tag Cloud.

6. Select the annotations to delete.

7. Click Delete Checked.

5.15 Managing Websheet Applications

From a Websheet, you can change your Websheet password, email a Websheet to another user, and print a Websheet.

- **Changing Your Websheet Password**
  Change your Websheet password by selecting Change My Password in the Administration menu.

- **Emailing a Websheet Page**
  Email a Websheet page by clicking its Email icon (envelope) located near the search bar.

- **Printing a Websheet Page**
  Print a Websheet page by clicking the Print icon (printer) located near the search bar.

5.15.1 Changing Your Websheet Password

Change your Websheet password by selecting Change My Password in the Administration menu.

To change your Websheet password:

1. Sign in to and run the Websheet.

2. From the Administration menu, select **Change My Password**.

   The Change Password page appears.

3. Follow the on-screen instructions and click **Change Password**.

5.15.2 Emailing a Websheet Page

Email a Websheet page by clicking its Email icon (envelope) located near the search bar.

To email a Websheet page:

1. Sign in to and run the Websheet.

2. Locate the page you want to email.

3. Click the Email icon above the Control Panel.
4. On the Email Page:
   a. To - Enter the target email address.
   b. Subject - Enter a description of this email.
   c. Body - Enter the email content you want to include along with the Websheet page link.

5. Click **Send**.

An email link to the currently selected page is automatically included in your email message.

---

**See Also:**

"Configuring Email" in *Oracle Application Express Administration Guide*

---

### 5.15.3 Printing a Websheet Page

Print a Websheet page by clicking the Print icon (printer) located near the search bar.

To print a Websheet in printer-friendly mode:

1. Sign in to and run the Websheet.
2. Click the **Print** icon above the Control Panel.

The page displays in printer-friendly mode.
3. Print the page.

## 5.16 Viewing Websheets

Use the options on the View menu to access presentation mode, view a page directory, access a page history, and view an application directory.

- **About Presentation Mode**
  You can use Presentation mode to view a single Websheet page as a presentation. Each page section displays one at a time as a slide.

- **Viewing the Page Directory**
  View the Page Directory by selecting Page Directory in the View menu.

- **Viewing Page History**
  View the history of a page by selecting Page History in the View menu.

- **Viewing the Websheet Directory**
  View the Websheet Directory by selecting Websheet Directory in the View menu.

### 5.16.1 About Presentation Mode

You can use Presentation mode to view a single Websheet page as a presentation. Each page section displays one at a time as a slide.

Users can navigate between sections by using the right and left arrow keys, by using the right and left arrow controls on the top right of the page, or by entering a section number to quickly jump to a specific section.

You can view a Websheet in presentation mode by clicking the **Presentation** icon (play button) located near the search bar.

In Presentation mode, each page section displays as a separate page.
5.16.2 Viewing the Page Directory

View the Page Directory by selecting Page Directory in the View menu.

The page history report shows old and new section content up to 4000 bytes. If the content you want to view exceeds the length of the report display, you can also query APEX$_WS_WEBPG_SECTION_HISTORY in your workspace schema.

To access the Page Directory:

1. Sign in to and run the Websheet.
2. From the View menu, select Page Directory.

The Page Directory displays as an interactive report. To learn more about interactive reports and using the Actions menu, see By default, the Page Directory displays in icon view.

One page in each Websheet is designated as the home page. The home page is the starting page that displays when you run the Websheet. In Icon view, the home page displays as a page with an outline of home.

3. To view the page as a report, click the View Report icon.

By default, Report view displays the following columns: Name, Doc Type, Created, Created By, Updated On, Updated By, Parent Page, and Grand Parent Page.

See Also:

• Using Interactive Reports
• Customizing an Interactive Report Using the Actions Menu

5.16.3 Viewing Page History

View the history of a page by selecting Page History in the View menu.

The page history report shows old and new section content up to 4000 bytes. If the content you want to view exceeds the length of the report display, you can also query APEX$_WS_WEBPG_SECTION_HISTORY in your workspace schema.

To view the Page History report:

1. Sign in to and run the Websheet.
2. Select a page.
3. From the View menu, select Page History.

The Page History displays as an interactive report.

A Search bar displays at the top of the page. Available controls include:

• Select columns to search - Resembles a magnifying glass. Click this icon to narrow your search. To search all columns, select All Columns.
• **Text area** - Enter case insensitive search criteria (wildcard characters are implied) to search for a page group by name and then click **Go**.

• **Go button** - Executes a search or applies a filter.

• **View Icons** - Displays each Websheet as a large icon.

• **View Report** - Displays each Websheet as a line in a report.

• **Actions menu** - Use the Actions menu to customize the report view.

4. To view changes in a Calendar format, click **Calendar**.

---

**See Also:**

Customizing an Interactive Report Using the Actions Menu

## 5.16.4 Viewing the Websheet Directory

View the Websheet Directory by selecting Websheet Directory in the View menu.

Use the Websheet Directory to navigate to another Websheet application.

To access the Websheet Directory:

1. Sign in to and run the Websheet.

2. From the View menu, select **Websheet Directory**.

   A Search bar displays at the top of the page. Available controls include:

   • **Select columns to search** - Resembles a magnifying glass. Click this icon to narrow your search. To search all columns, select **All Columns**.

   • **Text area** - Enter case insensitive search criteria (wildcard characters are implied) to search for a page group by name and then click **Go**.

   • **Go button** - Executes a search or applies a filter.

   • **View Icons** - Displays each Websheet as a large icon.

   • **View Report** - Displays each Websheet as a line in a report.

   • **Actions menu** - Use the Actions menu to customize the report view.

3. To view a Websheet, do one of the following:

   • In Icon view, click the appropriate icon.

   • In Report view, click the **Run** icon in the Actions column.

---

**See Also:**

Customizing an Interactive Report Using the Actions Menu
Index

A

Actions menu
  Aggregate, 3-9
  Chart, 3-9
  Compute, 3-9
  Control Break, 3-9
  Download, 3-9
  Filter, 3-9
  Flashback, 3-9
  Format, 3-9
  Group By, 3-9
  Help, 3-9
  Highlight, 3-9
  Reset, 3-9
  Rows Per Page, 3-9
  Save Report, 3-9
  Select Columns, 3-9, 3-11
  Sort, 3-9
  Subscription, 3-9

aggregation
  creating, 3-17
  removing, 3-18

Allow SQL and PL/SQL, about enabling, 5-29

annotations
  adding to Websheet, 5-45
  deleting, 5-45

Application Express
  browser requirement, 1-1

B

browser
  requirement, 1-1

C

chart
  deleting, 3-20
  editing, 3-20

D

data
  about adding, 5-28
  about editing, 5-28
  incorporating into Websheet pages, 5-29

data grid
  accessing Data page, 5-21
  adding annotation to single data row, 5-25
  copying, 5-20
  creating, 5-18
  deleting, 5-28
  editing columns manually, 5-23
  editing properties, 5-27
  editing rows manually, 5-24
  editing single row, 5-25
  pseudo columns, 5-26
  viewing and editing, 5-20
  viewing Change History log, 5-28

Data Loading Wizard
  about, 4-1
  example import from text file, 4-2
  example of copying and pasting, 4-5
  using, 4-1

data reports
  about, 5-30
  creating, 5-31
  deleting, 5-32
  editing, 5-32, 5-34
  viewing, 5-32

data section, adding to a Websheet page, 5-33

database applications, about, 1-2

E

editable interactive grids, 2-31, 2-34
  about, 2-3
  Cell Selection mode, 2-35, 2-36
  Clear, 2-38
  Copy Down, 2-36, 2-37
  Edit button, 2-33
  Fill, 2-38
  Row Actions menu, 2-32
  Row Selection mode, 2-35, 2-36
  rows, adding, 2-31
editable interactive grids *(continued)*  
rows, deleting, 2-35  
selection mode, 2-35, 2-36

F

Flashback query  
creating, 3-25  
deleting, 3-25  
editing, 3-25

G

group by  
about, 3-20  
creating, 3-21  
deleting, 3-22  
editing, 3-22  
sort order, 3-22

I

interactive grid filters, 2-13  
disabling, 2-15  
interactive grids, 2-1, 2-40  
about, 2-2  
accessing, 2-4, 2-5  
aggregation, creating, 2-17  
aggregations, editing, 2-19  
aggregations, removing, 2-20  
brack, 2-21, 2-25  
Cell Selection mode, 2-36  
chart, 2-10  
column heading menu  
about, 2-24  
Column Heading menu, 2-25  
column sort order, 2-9, 2-17  
column width, 2-8  
columns, 2-12  
control break, 2-21, 2-25, 2-27  
delete report, 2-42  
download, 2-44  
drag and drop, 2-7  
editable, 2-3, 2-31  
email, 2-44  
filtering by column, 2-30  
filters, 2-13  
flashback, 2-44  
freezing columns, 2-28  
hiding columns, 2-28  
highlight, 2-22  
refresh, 2-42  
report types, 2-39  
reset, 2-43

N

notes  
adding to Websheets, 5-44
P

Page Directory, viewing, 5-49
pivot report
  creating, 3-23
  creating deleting, 3-24
  editing, 3-24
private, 2-40
pseudo columns, 5-26

R

requirements
  browser, 1-1

S

single data grid row, editing, 5-25
single data row, adding annotation, 5-25

U

uploading data
  copy and pasting data, 4-5
  Data Load Wizard, 4-1
  importing data from a file, 4-2

W

Web browser
  requirements, 1-1
Websheet applications
  about, 1-2, 5-1, 5-2
  about adding charts, 5-34
  about adding data, 5-17
  about adding data sections, 5-17
  about annotations, 5-40
  about data grids, 5-18
  about data sections, 5-32
  about data sources, 5-29

Websheet applications (continued)
  about sections, 5-11
  about text sections, 5-13
  accessing Presentation Mode, 5-48
  adding chart sections, 5-34
  adding data sections, 5-33
  adding navigation, 5-16
  adding new pages, 5-9
  adding notes, 5-44
  adding tags, 5-43
  adding text sections, 5-14
  breadcrumb, 5-4
  common UI elements, 5-4
  Control Panel, 5-8
  copying a page, 5-9
  deleting sections, 5-12
  displaying tabular data, 5-18
  displaying uploaded images inline, 5-42
  editing charts, 5-36
  editing page details, 5-10
  editing section order, 5-12
  editing section titles, 5-12
  editing sections, 5-11
  editing text sections, 5-14
  emailing, 5-46
  including links to uploaded files, 5-42
  linking to a page, 5-37
  linking to data grid, 5-38
  linking to sections, 5-37
  linking to URLs, 5-37
  logging out, 5-6
  navigation sections, 5-4
  online Help, 5-6
  password, change, 5-46
  printing, 5-47
  pseudo columns, 5-26
  signing out, 5-6
  uploading files and images, 5-41
  URL of, 5-3
  using breadcrumbs, 5-4
  using SQL and SQLVALUE syntax, 5-38
  viewing directory, 5-50
  viewing Page Directory, 5-49
  viewing Page History, 5-49
  Websheet Search, 5-7

notes (continued)
deleting from Websheets, 5-44
editing, 5-44